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Preface

Manual Overview
The SEL-3031 Serial Radio Transceiver manual includes the information needed to 
properly install and operate the product.

The scope of this manual includes specifications, installation, mechanical information, 
self-monitoring, and alarming.

An overview of each manual section and topics follows.

Preface. Describes the manual organization and conventions used to present 
information.

Section 1: Introduction and Overview. Describes the basic features and functions 
of the SEL-3031, and lists the specifications.

Section 2: Installation. Describes how to mount and wire the SEL-3031; 
illustrates wiring connections for various applications.

Section 3: Job Done Examples. Describes common SEL-3031 applications.

Section 4: Settings and Commands. Describes settings and commands for use 
with the SEL-3031.

Section 5: Performance Monitoring, Testing, and Troubleshooting. Lists common 
operating and troubleshooting questions.

Appendix A: Firmware and Manual Versions. Details differences between 
firmware versions. Provides a record of changes made to the manual.

Appendix B: SEL-3044 Encryption Card. Describes how the encryption card 
operates to secure wireless data. Provides installation information.
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Conventions
Safety Information

This manual uses three kinds of hazard statements, formatted as follows:

Indicates a potentially hazardous situation that, if not avoided, may result in 
minor or moderate injury or equipment damage.

! CAUTION

Indicates a potentially hazardous situation that, if not avoided, could result in 
death or serious injury.

! WARNING

Indicates an imminently hazardous situation that, if not avoided, will result in 
death or serious injury.

! DANGER

SEL-3031 Cautions, Warnings, and Dangers
The following hazard statements appear in the body of this manual in English. See the 
following table for the English and French translation of these statements.

English French

Although the power level is low, concentrated 
energy from a directional antenna may pose a 
health hazard. Do not allow users to come 
closer than 23 cm (9 in) to the antenna when 
the transmitter is operating in indoor or 
outdoor environments in the 900-MHz band.

! CAUTION
Bien que le niveau de puissance soit bas, 
l'énergie concentrée d'une antenne 
directionnelle peut être un danger pour la 
santé. Ne pas autoriser les usagers à 
s'approcher à moins de 23 cm (9 po) de 
l'antenne quand l'émetteur est en opération 
dans un environnement intérieur ou 
extérieur dans la bande des 900-MHz.

! ATTENTION

The radio contains devices sensitive to 
electrostatic discharge (ESD). Undetectable 
permanent damage can result if you do not use 
proper ESD procedures. Ground yourself, your 
work surface, and this equipment before 
removing any cover from this equipment. If 
your facility is not equipped to work with these 
components, contact SEL about returning this 
device and related SEL equipment for service.

! CAUTION
La radio contient des circuits sensibles aux 
décharges électrostatiques (DES). Des 
dommages permanents non-décelables 
peuvent résulter de l’absence de précautions 
contre les DES. Raccordez-vous 
correctement à la terre, ainsi que la surface 
de travail et l’appareil avant d’en retirer un 
panneau. Si vous n’êtes pas équipés pour 
travailler avec ce type de composants, 
contacter SEL afin de retourner l’appareil 
pour un service en usine.

! ATTENTION
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ix

Operator safety may be impaired if the device is
used in a manner not specified by SEL.

! WARNING
La sécurité de l’opérateur peut être 
compromise si l’appareil est utilisé d’une 
façon non indiquée par SEL.

! AVERTISSEMENT

Atmospheric electrical charge accumulation 
can cause potential between the conductor and 
shield of the feedline, or cause lightning to 
strike an antenna. A lightning protector should 
be installed to prevent damage to equipment or 
injury to personnel.

! WARNING
L'accumulation de charges électriques de 
type atmosphérique peut être la cause d'une 
différence de potentiel entre le conducteur 
et le blindage de la  ligne d'alimentation ou 
peut attirer la foudre sur l'antenne. Un 
parafoudre devrait être installé pour 
prévenir les dommages à l'équipement ou 
les blessures au personnel.

! AVERTISSEMENT

Do not look into the fiber (laser) 
ports/connectors.

! WARNING
Ne pas regarder vers l’extremité des ports ou 
connecteurs de fibres pour laser.

! AVERTISSEMENT

Do not look into the end of an optical cable 
connected to an optical output.

! WARNING
Ne pas regarder vers l’extrémité d’un câble 
optique raccordé à une sortie optique.

! AVERTISSEMENT

This device is shipped with default passwords. 
Default passwords should be changed to private
passwords at installation. Failure to change 
each default password to a private password 
may allow unauthorized access. SEL shall not 
be responsible for any damage resulting from 
unauthorized access.

! WARNING
Cet appareil est expédié avec des mots de 
passe par défaut. A l’installation, les mots de 
passe par défaut devront être changés pour 
des mots de passe confidentiels. Dans le cas 
contraire, un accés non-autorisé á 
l’équipement peut être possible. SEL décline 
toute responsabilité pour tout dommage 
résultant de cet accés non-autorisé.

! AVERTISSEMENT

Disconnect or de-energize all external 
connections before opening this device. 
Contact with hazardous voltages and currents 
inside this device can cause electrical shock 
resulting in injury or death.

! DANGER
Débrancher tous les raccordements externes 
avant d’ouvrir cet appareil. Tout contact avec 
des tensions ou courants internes à l’appareil 
peut causer un choc électrique pouvant 
entraîner des blessures ou la mort.

! DANGER

English French
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Section 1
Introduction and Overview

Overview
The SEL-3031 is a 900-MHz, license-free, spread-spectrum radio. The radio operates 
in the ITU Region 2 ISM band of 902–928 MHz using a fast frequency-hopping 
algorithm for noise immunity and long-distance operation.

The SEL-3031 prevents the need for multiple sets of radios or expensive dedicated 
fiber transmitting over long distances. Figure 1.1 shows the flexibility of the SEL-3031 
in providing DNP3 SCADA information, MIRRORED BITS® control for reclosing 
coordination, and engineering access to the SEL-651R Recloser Control.

Figure 1.1 Product Overview

Pole-Mount Radio
Substation Radio

DNPEngineering
Access

MIRRORED BITS

SEL-3031

SEL-351S

SEL-651R

SEL-3031

SEL-3351
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1.2

Features, Benefits, and Applications
➤ Three Ports in One Radio Reduce Costs. Simultaneously 

communicates with up to three independent ports and protocols.

➤ Low Latency Enables Fast Control. Transfers control commands 
with a typical 5.5-millisecond latency with SEL MIRRORED BITS® 
communications.

➤ Strong Security Thwarts Attackers. Protects critical data and repels 
malicious attacks with optional encryption card, using session 
authentication and strong 256-bit Advanced Encryption Standard 
(AES) technology.

➤ Tough Radio Operates in Extreme Conditions. Is designed, built, 
and tested for trouble-free operation in extreme temperature, 
electromagnetic interference, shock, and vibration conditions.

➤ No Licensing Reduces Delays and Expenses. Uses the license-free, 
900-MHz ISM band for on-time, on-budget projects.

➤ Mounting Options Simply Installation. Order your SEL-3031 in 
one of three different packages: rack-mount, wall-mount, and NEMA 
3R prewired radio solution.

➤ Multiple Protocols Satisfy Interconnection Requirements. 
Communicate with industry-standardized byte-oriented protocols, 
such as DNP3, Modbus®, SEL MIRRORED BITS communications, 
IEEE C37.118 Synchrophasors, SEL Fast Messaging, and SEL 
ASCII.

➤ Flexible Serial Port Options Match Integration Needs. Order 
serial Port 1 as EIA-232, EIA-485, or optical fiber to easily connect 
to your existing devices.

➤ Simple Settings Streamline Radio Commissioning. Use 
ACSELERATOR QuickSet® SEL-5030 Software for all settings.

➤ USB Management Port Conveniently Connects to PC. Make 
settings changes, verify status information for proper installation, and 
verify radio performance without affecting the three serial channels.

Models, Options, and Accessories
Standard Features

➤ Three EIA-232 serial ports

➤ IRIG-B time code input



Date Code 20091009 SEL-3031 Instruction Manual

Introduction and Overview
Models, Options, and Accessories

1.3

➤ Power supply
➢ Wall mount: 9–30 Vdc
➢ Rack mount: 24–48 Vdc, 125/250 Vac or Vdc

➤ ACSELERATOR QuickSet software

➤ Protocol pass-through support

➢ DNP3
➢ Modbus
➢ SEL MIRRORED BITS

➢ SEL Fast Messaging
➢ SEL ASCII
➢ IEEE C37.118 Synchrophasors

Optional Features
➤ One port EIA-485

➤ One port fiber-optic (SEL-2812-compatible)

➤ SEL-3044 Encryption Card

Accessories

Table 1.1 Radio Antenna and Cable Accessories 

Description Part Number

Feed Line

RG-8 TNC to N Connector C964

RG-8 TNC to TNC C965

LMR-400 TNC to N Connector C966

LMR-400 TNC to TNC C961

Antenna

Three-element 8.5 dBi Yagi, N Connector 235-0221

Five-element 11.1 dBi Yagi, N Connector 235-0220

Vertical 2.15 dBi Gain Omni-directional, N Connector 235-0231

Surge Protection

Gas Tube Coaxial Surge Protector, TNC Connector 915900139



SEL-3031 Instruction Manual Date Code 20091009

Introduction and Overview
Product Diagrams

1.4

Product Diagrams

Figure 1.2 SEL-3031 Dimensions
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Figure 1.3 SEL-3031 Rack Mount (Front and Rear)
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Figure 1.4 SEL-3031 Wall Mount (Front and Rear)
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1.7

Specifications

General

Temperature Range

–40° to +85°C per IEC 60068-2-1 and 
60068-2-2

Operating Environment

Pollution 
Degree: 2

Relative 
Humidity: 5–95%, noncondensing

Maximum 
Altitude: 2000 m

Dimensions

Wall Mount: 43.9 mm x 219.7 mm x 
162.6 mm
(1.73 in x 8.66 in x 

6.40 in)

Rack Mount: 43.7 mm x 482.6 mm x 
160.0 mm

(1.72 in x 19.00 in x 
6.3 in)

Time-Code Input

Port 2, Pins 4 and 6

Format: Demodulated IRIG-B

Input 
Impedance: 333 

Accuracy: ± 5 milliseconds

Alarm Contact

Form B Contact 
(open when energized and passes diagnostics)

Operating 
Voltage: 250 Vdc or 190 Vac

Dielectric Test 
Voltage: 500 Vrms

Continuous 
Carry: 6 A

Communications

Communications Ports

Serial Port 1: EIA-232, EIA-485 
(ordering option)

SEL-2812 Fiber-Optic 
Port (ST connectors)

Data Speed: 19200 bps; 
9600 bps with encryption 
card

Serial Port 2, 3: Standard EIA-232
Data Speed: 19200 bps; 
9600 bps with encryption 
card

Protocols Supported

Modbus, DNP3, SEL MIRRORED BITS 
Communications (MB8), ACSELERATOR 
QuickSet SEL-5030 Software Support, 
SEL ASCII and Compressed ASCII, SEL 
Fast Messaging, IEEE C37.118 
Synchrophasors

Radio Latency

SEL-3031

MIRRORED BITS: 5.5 ms typical

Standard: 4 ms typical

SEL-3031 With SEL-3044 Encryption Card

MIRRORED BITS: 16 ms typical

Standard: 15 ms typical

Radio

Transmitter

Frequency Band: 902–928 MHz ISM band

Modulation: GFSK

Operating Mode: Point-to-Point

RF Connector: TNC

Power Output: 1 W (30 dBm) to 
100 mW (20 dBm) 
in steps of 1 dBm

Channel 
Bandwidth: 250 kHz
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Receiver

Sensitivity: –97 dBm

Bit Error Rate 
(BER): <10–6 at –97 dBm

Distance: 20 miles, line of sight

Error Detection: 32-bit CRC (MB8 mode)

Power Supply

Rated Supply Voltage

Wall-Mount 
Model: 12/24 Vdc

Low-Voltage 
Model: 24/48 Vdc

High-Voltage 
Model:

125/250 Vdc
110/240 Vac, 50/60 Hz

Input Voltage Range

Wall-Mount 
Model: 9–30 Vdc

Low-Voltage 
Model: 18–60 Vdc

High-Voltage 
Model: 85–275 Vdc; 85–264 Vac

Power Consumption

Wall Mount: < 5 W

Rack Mount: < 7 W

Type Tests

Communications Equipment Tests

IEEE 1613-2003

Environmental Tests

Enclosure 
Protection: IEC 60529:2001

Vibration 
Resistance:

IEC 60255-21-1:1988 
Class 1 Endurance, 
Class 2 Response

IEC 60255-21-3:1993
Class 2

Shock 
Resistance:

IEC 60255-21-2:1988 
Class 1 shock withstand, 
bump,
Class 2 shock response

Cold: IEC 60068-2-1:2007 
–40°C, 16 hours

Damp Heat, 
Cyclic:

IEC 60068-2-30:2005 
25–55°C, 6 cycles, 95% 
relative humidity

Dry Heat: IEC 60068-2-2:2007 
+85°C, 16 hours

Dielectric Strength and Impulse Tests

Dielectric 
(HiPot):

IEC 60255-5:2000
IEEE C37.90–2005

Impulse: IEC 60255-5:2000
0.5 J, 5 kV

RFI and Interference Tests

EMC Immunity

Standard: IEEE 1613, Class 2

Electrostatic 
Discharge:

IEC 61000-4-2:2008
Severity Level 4
8 kV contact discharge
15 kV air discharge

IEEE C37.90.3–2001
Severity Level 4
8 kV contact discharge
15 kV air discharge

Radiated RF 
Immunity:

IEC 61000-4-3:2008 
10 V/m

IEEE C37.90.2–2004
35 V/m

Fast Transient, 
Burst 
Immunity:

IEC 61000-4-4:2004 
4 kV @ 2.5 kHz, and 5.0 
kHz for communications 
ports, power supply, 
alarm contacts

Surge Withstand 
Capability 
Immunity:

IEC 60255-22-1:2007
2.5 kV common-mode, 
1 kV differential-mode

IEEE C37.90.1–2002 
2.5 kV oscillatory, 4 kV 
fast transient for 
communications ports, 
power supply, alarm 
contacts

Conducted RF 
Immunity:

IEC 61000-4-6:2008
10 Vrms

Digital Radio 
Telephone RF 
Immunity:

ENV 50204-1995 
Severity Level 10 V/m at 
900 MHz and 1.89 GHz
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EMC Emissions

Radiated Emissions

FCC Part 15.247; ICES-001; RSS-210
This device complies with Part 15 of the 

FCC rules. Operation is subject to the 
following two conditions:

1. This device may not cause harmful 
interference, and

2. This device must accept any interference 
received, including interference that may 
cause undesired operation.

FCC Part 15, Class A; ICES-003
Note: This equipment has been tested and 

found to comply with the limits for a 
Class A digital device, pursuant to Part 
15 of the FCC Rules. These limits are 
designed to provide reasonable 
protection against harmful interference 
when the equipment is operated in a 
commercial environment.

This equipment generates, uses, and can 
radiate radio frequency energy and, if not 
installed and used in accordance with the 
instruction manual, may cause harmful 
interference to radio communications.

Operation of this equipment in a 
residential area is likely to cause harmful 
interference in which case the user will 
be required to correct the interference at 
his own expense.

FCC Section 15.21
Users manual for an intentional or 

unintentional radiator shall caution the 
user that changes or modifications not 
expressly approved by the party 
responsible for compliance could void 
the user’s authority to operate the 
equipment.

Certifications
ISO: Equipment designed and manufactured 

using ISO 9001-certified quality program.

FCC ID: R34SEL - 3031

IC: 4468A - SEL3031
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Section 2
Installation

Overview
RF Exposure Notice

The SEL-3031 transmitter module is approved for use only with specific 
antenna, cable, and output power configurations that have been tested and 
approved for use. Modifications to the SEL-3031, the antenna system, or 
to the power output that have not been explicitly specified by the 

manufacturer are not permitted and may render the radio non-compliant with 
applicable regulatory authorities. The radio equipment described in this manual emits 
radio frequency energy. Professional installation is required. The antenna(s) for this 
transmitter must not be colocated or operated in conjunction with any other antenna or 
transmitter.

! CAUTION
Although the power level is low, concentrated energy from a directional 
antenna may pose a health hazard. Do not allow users to come closer than 
23 cm (9 in) to the antenna when the transmitter is operating in indoor or 
outdoor environments in the 900-MHz band.

FCC Part 15 Notice

NOTE: Operation is subject to the following two conditions: 
(1) this device may not cause interference, and (2) this 
device must accept any interference, including 
interference that may cause undesired operation of the 
device.

This equipment has been tested and found to comply with the limits for Class A digital 
devices, pursuant to FCC Part 15 Rules. These limits are designed to provide 
reasonable protection against harmful interference when the equipment is operated in a 
commercial environment. This equipment generates, uses, and radiates radio frequency 
energy, and if not installed and used in accordance with the instruction manual, may 
cause harmful interference to radio communications. Operation of this equipment in a 
residential environment is likely to cause harmful interference, in which case the user 
will be required to correct the interference at his/her own expense.

RF EXPOSURE
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Radio Path
Spread-spectrum radios operating in the 900-MHz ISM band are limited by line-of-
sight. Radio line-of-sight is longer than optical line-of-sight, due to the bending of the 
radio wave toward the surface of the earth. This radio horizon is typically 30% longer 
than the visual horizon. The longer the communications path, the taller the antennas 
must be in order to maintain the line-of-sight.

Obstructions in the line-of-sight will impact the performance of the radio, as the 
strongest radio signal is communicated directly along the radio line-of-sight.

The line-of-sight between two antennas is shaped like an ellipse (called the Fresnel 
zone). The point exactly halfway between the two antennas is the widest part of the 
ellipse, as shown in Figure 2.1. At 900 MHz and 1000 feet apart, the Fresnel zone is 
16 feet in diameter. At 20 miles apart, it is 170 feet in diameter. Anything within the 
Fresnel zone will obstruct and reduce signal strength and availability (the ground, 
buildings, vegetation, etc.). Table 2.1 depicts the maximum Fresnel zone diameter and 
path loss for some typical path distances.

Figure 2.1 Fresnel Zone

The formula used to calculate the widest distance of the Fresnel zone is as follows:

where:

b = radius of the Fresnel zone in meters
d = distance between transmitter and receiver in kilometers
f = frequency transmitted in GHz

d

b

b 17.32 d 4f =
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Obstructions in the Fresnel zone may also cause multipath interference due to 
reflective or refractive signals that may arrive at the receiver out-of-phase with the 
desired signal. The Fresnel zone should be 60% clear of obstructions for reliable radio 
communications. Large objects outside the Fresnel zone can cause reflections that may 
also affect reliable radio operation.

Transmitted Signal
According to FCC and IC, the maximum transmitted power allowed out of an antenna 
is 36 dBm EIRP (Equivalent/Effective Isotropically Radiated Power). This is the 
amount of equivalent power transmitted equally in all directions using a theoretical 
isotropic antenna. EIRP takes into account the power output of the radio, line feed 
losses, and the gain of the antenna. 

EIRP = SEL-3031 Power Output (dBm) – line-feed loss (dB) + antenna gain (dBi)

Calculate the EIRP so you can set the proper output power on the SEL-3031 to stay in 
compliance with FCC and IC regulations; maximum power output from the antenna 
must not exceed 36 dBm. The SEL-3031 can transmit up to 1 W or 30 dBm from the 
antenna port. If the calculated EIRP exceeds 36 dBm then you must reduce the power 
transmitted by the radio by reducing the transmit power setting TXPWR (see the TXPWR 
description in Radio Settings on page 4.12 for more information). The radio is shipped with 
30 dBm default and can be reduced to 20 dBm. Look up feedline loss in Table 2.3. 
Antenna/feedline configurations with net gains (antenna gain minus cable loss) greater than 
8.0 dBi must have their output power limited to 341 mW. After setting the transmit power, 
measure the actual power.

NOTE: This device has been designed to operate with the 
antennas listed in Table 1.1, and having a maximum gain of 
11.1 dBi. Antennas not included in this list or having a gain 
greater than 11.1 dBi are strictly prohibited for use with 
this device. The required antenna impedance is 50 ohms. 
Antennas having a gain of greater than 6 dB must use a 

Table 2.1 Fresnel Zone Diameter

900 MHz

Distance Between Antennas Fresnel Zone Diameter Freespace Loss (dB)

300 m (1000 ft) 5 m (16 ft) 81

1.6 km (1 mi) 11.6 m (38 ft) 96

8 km (5 mi) 26 m (85 ft) 110

16 km (10 mi) 36.6 m (120 ft) 116

24 km (15 mi) 44.8 m (147 ft) 119

32 km (20 mi) 51.8 m (170 ft) 122

40 km (25 mi) 60 m (190 ft) 124
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feed line with enough loss to remain compliant with the 
maximum 36 dBm EIRP or reduce the radio transmitted 
power accordingly.

For example, if you wanted to design a radio system to achieve a 32-km (20-mile) radio 
path and run at the highest allowed transmitted power, one way would be to use the 
SEL-3031 with 15 meters (50 feet) of LMR 400, lightning arrestor, and the 5-Element 
Yagi with 11.1 dBi of gain. The radio would transmit 30 dBm, the feedline loss is 1.95 
dB, lightning arrestor loss is 0.15 dB, and the antenna gain is 11.1 dBi. The result 
would be 39 dBm, which is 3 dBm higher than allowed by the FCC. You must reduce 
the radio’s transmit power setting TXPWR to 27 dBm. This would make your EIRP 
equal to 36 dBm. After setting the transmit power, measure the actual power.

NOTE: To reduce potential radio interference to other 
users, the antenna type and its gain should be so chosen 
that the equivalent isotropically radiated power (EIRP) is 
not more than that permitted for successful 
communication.

Fade Margin
The fade margin determines the allowable signal loss between the transmitter and 
receiver. The fade margin is a function of system gains (transmitter power, receiver 
sensitivity, and antenna gain) and system losses (free space loss, losses due to Earth’s 
curvature, and coaxial cable loss). Variations in temperature and humidity of the 
atmosphere with elevation causes the signals to bend more or bend less, resulting in 
fading at the receiver. The longer the path, the more likely deep fades will occur, 
requiring a greater fade margin. The formula to calculate free-space loss is shown 
below.

Free Space Loss = 92.4 + 20log(f) + 20log(d) dB

where: 

f = frequency in GHz
d = distance in km

Regional conditions also impact the probability of signal fade. Generally, mountainous 
terrain is more favorable, while tropical areas and those near large bodies of water are 
less favorable. One of the results from a site survey is the fade margin. A fade margin 
of 20 dB will yield good radio performance.

Site Survey
A line-of-sight path provides the most reliable transmission in all cases. As the distance 
increases the need for a clear path becomes more critical in creating a reliable, 
available radio link. If the radio path is short then a path study may not be needed. If 
you have a clear line-of-site to the other location without obstructions to the Fresnel 
zone (see Radio Path) then a path study is generally not needed. Longer distances may 
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require a path study, a visual path inspection, and a spectrum analysis of the area to 
give a good indication of how high the antenna needs to be and how good the radio link 
will be.

Radio Interference
The SEL-3031 shares a frequency spectrum with other services and FCC Part 15 
(unlicensed) devices in ITU Region 2 (North, Central, and South America). This radio 
should not be used in Brazil or Chile due to the regulations defining frequency 
allocation. Error-free communications may not be achievable in a given location, and 
some level of interference should be expected.

Consider the following points when setting up your system:

➤ Using directional Yagi antennas helps to narrow the radio path and 
provide the best path to prevent adjacent interference.

➤ If you suspect interference from a nearby, licensed system (such as a 
paging transmitter), it may be helpful to use horizontal polarization 
for all of the antennas in the network. Horizontal polarization can 
help improve signal availability but will likely increase the path loss. 
Horizontal polarization can provide an additional 20 dB of 
attenuation to interference because most other services use vertical 
polarization in these bands. Figure 2.2 demonstrates antenna 
mounting for both vertical and horizontal polarization.

Figure 2.2 Antenna Polarization

➤ Multiple SEL-3031 systems can coexist in close proximity with 
minimal interference as long as each SEL-3031 is assigned a unique 
network address. Each network identification uses a specific hop 
pattern and number of frequency zones.

Vertical Polarization Horizontal Polarization
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➤ When constant interference is present in a particular frequency zone, 
it may be necessary to “lock out” that zone from the SEL-3031 
hopping pattern. The SEL-3031 includes a SKIP setting that removes 
interfered frequency zones from its hopping pattern. See Table 4.5 for 
more information on the skip zones and information on how to set the 
SKIP setting. In the USA and Canada, a maximum of six zones may 
be skipped, per FCC and IC rules. Check the regulatory requirements 
for your country.

➤ The RF power output for all SEL-3031 radios in your system should 
be set to the lowest level necessary for reliable communications. This 
decreases the likelihood of causing unnecessary interference to 
nearby systems. See Table 2.2 for more information on the different 
frequency zones.

Feedlines
The feedline used with the antenna is as important as the antenna. Coaxial cables 
should have low attenuation and rated for outdoor use. Keep the feedline as short as 
possible to minimize signal loss between the radio and antenna. Times Microwave 
LMR 400® or RG-8 A/U coax cables are preferred. If longer lengths or less loss is 
desired for the radio link then larger cable such as Andrew HELIAX® can be used. 
Table 2.3 lists the signal losses (in dB) for the indicated lengths of each cable type at 
900 MHz. 

Table 2.2 900-MHz Frequency Skip Zones

Zone 1 Zone 2 Zone 3 Zone 4 Zone 5 Zone 6 Zone 7 Zone 8

902.6–
903.8

904.1–
905.3

905.6–
906.8

907.1–
908.3

909.2–
910.4

910.7–
911.9

912.2–
913.4

913.7–
914.9

Zone 9 Zone 10 Zone 11 Zone 12 Zone 13 Zone 14 Zone 15 Zone 16

915.2–
916.4

916.7–
917.9

918.2–
919.4

919.7–
920.9

921.2–
923.0

923.3–
924.5

924.8-
926.0

926.3-
927.5

Table 2.3 Length vs. Loss in Coaxial Cables at 900 MHz (Sheet 1 of 2)

Cable Type
3.05 Meters 

(10 Feet)
12.24 Meters 

(50 Feet)
30.48 Meters 

(100 Feet)
91.44 Meters 

(300 Feet)

RG-8 A/U 
(C964)

0.70 dB 3.50 dB 7.0 dB Unacceptable 
Loss

LMR 400 
(C966)

Do not use 1.95 dB 3.90 dB Unacceptable 
Loss

1/2-inch 
HELIAX

Do not use 1.15 dB 2.29 dB 6.87 dB
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Antenna System Ground
Antenna system grounding is not included in the scope of this manual. Please consult a 
radio systems engineer or other professional for advice on ground-system design. A 
well-designed system will minimize equipment damage and risk of electric shock to 
personnel.

Chassis Ground
Connect the grounding terminal labeled GND on the rear panel to a rack frame 
ground or main station ground for proper safety and performance. Use 4 mm2 
(12 AWG) or heavier wire less than 2 meters (6.6 feet) in length for this 

connection. The ground connection should be made before the power connections.

Connections
Rear-Panel Connections

The physical layout of the SEL-3031 connections is shown in Figure 2.3.

Figure 2.3 Wall-Mount and Rack-Mount Rear Connections

7/8-inch 
HELIAX

Do not use 0.64 dB 1.28 dB 3.84 dB

1-1/4-inch 
HELIAX

Do not use Do not use 0.95 dB 2.85 dB

1-5/8-inch 
HELIAX

Do not use Do not use 0.80 dB 2.4 dB

Table 2.3 Length vs. Loss in Coaxial Cables at 900 MHz (Sheet 2 of 2)

Cable Type
3.05 Meters 

(10 Feet)
12.24 Meters 

(50 Feet)
30.48 Meters 

(100 Feet)
91.44 Meters 

(300 Feet)
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Power Connections
The POWER terminals on the rear panel (labeled +/H and -/N) must connect to the 
correct supply voltage. The supply voltage range is located on the serial label. The 
wall-mount configuration accepts only 9–30 Vdc. The rack-mount configuration 
accepts 24–48 Vdc or 125/250 Vac or Vdc. Check the serial label for power supply 
information.

Do not apply power to the SEL-3031 without having a proper 50- load on the antenna 
port. If you do not have the proper 50- load connected, the radio antenna port will 
shut off, the alarm contact will pulse, and the ALARM LED will illuminate. This 
functionality protects the radio circuitry and indicates an antenna or cable failure. The 
POWER terminals on the rack-mount version are isolated from chassis ground. The 
POWER terminals on the wall-mount version are not isolated from chassis ground. Use 
2.5 mm2 (14 AWG) size wire to connect to the POWER terminals on the rack mount. 
Place an external circuit breaker or switch no more than 3 meters (9.8 feet) from the 
equipment. The circuit breaker (or equivalent approved disconnect device appropriate 
for the country of installation) must comply with IEC 60947-1 and IEC 60947-3, be 
identified as the disconnect device for the equipment, and be located near the 
equipment. This disconnect device must interrupt both the hot (+/H) and the neutral 
(–/N) power leads. The maximum current rating for the power disconnect circuit 
breaker or overcurrent device (fuse) must be 20 A. An internal power supply fuse 
protects the operational power supply. Be sure to use fuses that comply with 
IEC 60127-2.

Lightning Protection
! WARNING

Atmospheric electrical charge accumulation can cause potential between the 
conductor and shield of the feedline, or cause lightning to strike an antenna. 
A lightning protector should be installed to prevent damage to equipment or 
injury to personnel.

Mounting the antenna on an equipment building roof or tower is safest because the 
potential rise on the outside of either of these structures will approximately equal the 
potential on the inside. A lightning protector (Gas Tube Coaxial Surge Protector, SEL 
part number 915900139) should be used to equalize the difference in potential that can 
occur between the center conductor and the shield of the coaxial cable between the 
antenna and the radio. The higher the antenna is mounted on a support structure, the 
greater the probability of equipment damage resulting from a lightning strike. 

In all surge-protector applications, you should mount the surge protector at the building 
or enclosure entrance, and ground the surge-protector body. Ground the radio to the 
same point as the surge-protector ground to avoid ground-rise-potential damage. 

When using the surge protector, order an additional C965 or C961 cable and place this 
cable between the SEL-3031 and the surge protector. Because the distance varies from 
the SEL-3031 to the surge protector, be sure to specify this cable at approximately the 
correct length (plus 10 to 20 percent for installation variability).
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Grounding (Earthing) Connections
You must connect the ground terminal labeled GND to a rack frame or 
switchgear ground for proper safety and performance. Use 2.5 mm2 (14 AWG) 
wire less than 2 meters (6.6 feet) in length for the ground connection.

Serial Ports
Because all ports (1, 2, and 3) are independent, you can communicate to any 
combination simultaneously. All EIA-232 ports accept DB-9 male connectors. The 
serial port EIA-485 option for Port 1 is also a DB-9 male connector. If Port 1 is ordered 
with the EIA-485 option the product will ship with a DB-9-to-terminal adapter to 
easily wire to EIA-485 systems. Port 2 includes the IRIG-B time-code signal input (see 
Table 2.6). SEL offers fiber-optic transceivers or fiber-optic port options on Port 1 
(SEL-2812 compatible optic) for connecting devices at distances over 15 meters (50 
feet) where copper cable is not appropriate. The SEL-2800 family of transceivers 
provides fiber-optic links between devices for electrical isolation and longer distances, 
overcoming the limitations of electrical EIA-232 interfaces. Contact SEL for further 
information on these products.

Front-Panel Jumpers
The front panels of the rack- and wall-mount configurations contain two jumpers. 
Access to the jumpers is different for each configuration. Note that jumper number 1  
(JMP1) is for factory use only and should not be installed.

The radio contains devices sensitive to Electrostatic Discharge (ESD). 
Undetectable permanent damage can result if you do not use proper ESD 
procedures. Ground yourself, your work surface, and this equipment before 
removing any cover from this equipment. If your facility is not equipped to 
work with these components, contact SEL about returning this device and 
related SEL equipment for service.

! CAUTION

Wall-Mount Chassis Jumper Access
From the front of the wall-mount configuration, remove the four screws located on the 
sides of each corner. Use a Torx® T15 size screwdriver to remove the four screws. 
Slide the back cover up and to the back of the unit to reveal the front jumpers. You do 
not need to remove the ribbon cable to change jumpers. The jumpers are located to the 
left of the USB connector.

Rack-Mount Chassis Jumper Access
From the front of the rack-mount configuration, remove the front panel by loosening 
the six screws and removing the front panel. You will find the jumpers to the left of the 
USB connection.
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Password Jumper
The SEL-3031 contains two levels of passwords to access and set the radio. The 
Level 1 password is for read access and the Level 2 password is for write access. The 
default passwords that are shipped with the SEL-3031 are shown in Table 2.4. Do not 
leave factory default passwords in the product. See PASSWORD Command on 
page 4.19 for more information on setting passwords. 

If necessary, you can disable passwords by installing a jumper. Refer to PASSWORD 
Command on page 4.19 for information on properly disabling and changing 
passwords. 

Table 2.4 Default Passwords

Access Level Password

1 OTTER

2 TAIL

Table 2.5 Password Jumper Position

Password Enable/Disable Jumper Position

Jumper Installed (Password Disabled)

The jumper installed disables the passwords.

Jumper Removed (Default) 

The SEL-3031 ships by default with passwords enabled.

JM
P2

JM
P2
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IRIG-B Time-Code Input
The SEL-3031 accepts a demodulated IRIG-B time signal to synchronize the internal 
clock with an external time source. IRIG-B is available on Port 2 utilizing Pins 4 and 6 
for time communications. The SEL-3031 supports the IRIG-B002 standardized time 
format.

Front-Panel Indicators
The SEL-3031 has ten front-panel LED indicators. Table 2.7 further describes these 
indicators that display the current status of the radio. The LINK LED indicates when the 
SEL-3031 has properly connected to another SEL-3031. The SEC LED deals with the 
SEL-3044 Encryption Card. See Appendix B: SEL-3044 Encryption Card for more 
information on using this card.

Table 2.6 Communications Cables for Time and Communications Connections

EIA-232 Serial Port Connect to Device SEL Cable No.

Port 2 IRIG-B BNC with time only C256

SEL communications processors and com-
puting platform data with IRIG-Ba

a. If connecting to an SEL communications processor you must turn the 5V_EN Global setting in 
the SEL-3031 to OFF.

C387

IRIG-B only from DB-9 on SEL-2407® C388

Table 2.7 Front-Panel Status Indicator LEDs

Label Color Description

ENABLE Green All self tests are passing and unit is operational

ALARM Red ON: Self test failure detected

Flashing: Antenna failure

SEC Green ON: Encryption card detected and wireless data secured

Flashing: Encryption card detected and in RESET

OFF: No encryption card present or card failed

LINK Green Communications link established between master and remote radio

TX 1, 2, 3 Green Serial data received by the port and transmitted out of the radio

RX 1, 2, 3 Green Radio data received and transmitting out of serial port
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Communications
Serial Ports

Table 2.8 shows the physical interfaces of the SEL-3031. Several options are provided 
for Port 1 physical interfaces, including EIA-232, EIA-485, and fiber.

Serial (EIA-232 and EIA-485)
Use the EIA-232 port for communications distances of 15 meters (50 feet) in 
low-noise environments. Use the optional EIA-485 Port 1 for communications of 
1200 meters (4000 feet) maximum distance (to achieve this performance, ensure 
proper line termination at the receiver). 

If Port 1 is an EIA-485 connection, there are two types of connections that will work on 
multidrop systems. Table 2.9 shows the standard pinout of a recommended four-wire 
EIA-485 connection. If your system only works on a two-wire EIA-485 connection, 
then you will need to connect Pins 1 and 3 together and Pins 2 and 4 together. 
Figure 2.4 shows how to wire this configuration.

Figure 2.4 Two-Wire EIA-485 Connections

Table 2.8 SEL-3031 Port Description

Port Communications Interface Location

Port 1 EIA-232, EIA-485, or fiber Rear (Port 1 has three ordering options)

Port 2 EIA-232 Rear

Port 3 EIA-232 Rear

USB USB 1.1 Front (management port)

Port 1 EIA-485
9-Pin Male
D Subconnector
2-Wire EIA-485

2-Wire EIA-485
Tinned Wires

1
3
2
4
5

1

2

3

TX+
RX+
TX–
RX–

GND

Pin # Pin #
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Fiber-Optic Serial Port
Order the fiber-optic option for Port 1 for safety and long-distance communications up 
to 4 kilometers (2.5 miles). The fiber-optic port is an SEL-2812-compatible device that 
can connect directly to any SEL-2812-compatible device or SEL-2812 fiber optic 
transceiver, using multimode fiber-optic cable with a core diameter of 50 to 200 
micrometers. When working with this device, observe the following safety 
precautions:

! WARNING

➤ Do not look into the fiber (laser) ports/connectors.

➤ Do not look into the end of an optical cable connected to an optical 
output.

➤ Do not perform any procedures or adjustments that this instruction 
manual does not describe.

➤ During installation, maintenance, or testing of the optical ports, use 
only test equipment qualified for Class 1 laser products.

➤ Incorporated components, such as transceivers and laser emitters, are 
not user serviceable. Return units to SEL for repair or replacement.

Port Connector and Communications Cables
Figure 2.5 shows the EIA-232 and EIA-485 DB-9 connector pin numbering for the 
SEL-3031.

Figure 2.5 EIA-232 and EIA-485 DB-9 Connector Pin Numbers

Table 2.9 shows the pin function of the serial ports.

Table 2.9 SEL-3031 Port Description (Sheet 1 of 2)

Pin
Port 1, Port 3

EIA-232
Port 2

EIA-232
Port 1

EIA-485

1 +5 Vdc +5 Vdc TX+

2 RXD RXD TX-

3 TXD TXD N/C

4 N/C IRIG+ N/C

5 GND GND GND

5  4  3  2  1

9  8  7  6
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Cleaning
Use care when cleaning the SEL-3031. Perform the following steps:

Step 1. Use a mild soap or detergent solution and a damp cloth to clean the 
chassis.

Step 2. Be careful cleaning the front and rear panels because a permanent 
plastic sheet covers each panel.

Do not use abrasive materials, polishing compounds, or harsh chemical solvents (such 
as xylene or acetone) on any surface.

Cables

Figure 2.6 SEL Cable C245A: SEL-3031 to Computer

6 N/C IRIG– N/C

7 RTS RTS RX+

8 CTS CTS RX–

9 GND GND GND

Table 2.9 SEL-3031 Port Description (Sheet 2 of 2)

Pin
Port 1, Port 3

EIA-232
Port 2

EIA-232
Port 1

EIA-485

SEL-3031 
9-Pin Male
Subminiature "D" Connector

9-Pin Female
Subminiature "D" Connector

2
3
5
7
8

2
3
5
7
8

RXD
TXD
GND
RTS
CTS

RXD (OUT)
TXD (IN)
GND
RTS (IN)
CTS (OUT)

Pin
Func.

Pin
Func.Pin # Pin #

PC Device

NOTE: For best results, limit the cable length to 15 meters (50 ft)

ORANGE
RED

BLUE/SHIELD
GREEN
WHITE
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Figure 2.7 SEL Cable C285: SEL-3031 to DTE Device (SEL Relays)

Figure 2.8 SEL Cable C782/C387: SEL-3031 to SEL Communications 
Processor

USB Interface
The SEL-3031 uses a standard USB Type-B interface for the management port. The 
USB interface is used for settings management, initial radio installation, and reporting 
data from long-term radio statistics. The management port may be used while the 
SEL-3031 is in service without disrupting the radio communications. To use this 
interface, plug a USB Type-B cable into the radio and plug the other end into your PC. 
This will automatically prompt your PC to install a USB-to-serial driver that creates a 
virtual serial port. The virtual serial port needs to be set to 9600 bps, 8 data bits, 1 stop 

SEL-3031 
9-Pin Male
Subminiature "D" Connector

No IRIG
9-Pin Male
Subminiature "D" Connector

2
3
5
7
8

2
3
5
7
8

RXD
TXD
GND
RTS
CTS

Pin
Func. Pin # Pin #

DTE Device

NOTE: For best results, limit the cable length to 15 meters (50 ft)

ORANGE
RED

BLUE/SHIELD
GREEN
WHITE

SEL-3031 
9-Pin Male
Subminiature "D" Connector

With IRIG
9-Pin Male
Subminiature "D" Connector

1
2
3
4
5
6
7
8
9

1
2
3
4
5
6
7
8
9

Pin # Pin #

NOTE: For best results, limit the cable length to 15 meters (50 ft)

CAUTION: You must turn off the +5 V on Pin 1 of the SEL-3031 when 
connecting to a communications processor.

SEL Communications Processor
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bit, and no parity to properly communicate with the SEL-3031. This virtual serial port 
can now be used with ACSELERATOR QuickSet® SEL-5030 Software to help set and 
view settings and obtain report information.

Figure 2.9 USB Interface

SEL-3031
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Overview
This section describes how to set up a serial port for two popular types of protocols: 
MIRRORED BITS® and SEL Fast Messaging. This section assumes you have established 
a radio link. If you are having problems setting up the radio link, refer to Section 2: 
Installation and Section 5: Performance Monitoring, Testing, and Troubleshooting for 
more information.

Each of the sections below describes how to set up the SEL-3031 serial port and the 
end devices to make a proper connection.

High-Speed Teleprotection or Control With 
MIRRORED BITS Communications

Figure 3.1 SEL MIRRORED BITS Connection Example

The SEL-3031 can handle up to three connections of MIRRORED BITS simultaneously 
over one radio link. For this example there are three MIRRORED BITS channels over the 
SEL-3031. This example shows you how to set the radio and set different end devices 
to properly use the radio as MIRRORED BITS links.

SEL-351

SEL-2505

SEL-2100

SEL-3031SEL-3031
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3.2

SEL-3031 MIRRORED BITS Settings
For Figure 3.2 we set Port 1 on both SEL-3031 devices as a MIRRORED BITS 
connections.

On each radio set the following settings on the Port 1 settings.

g

Figure 3.2 SEL-3031 Port Settings for MIRRORED BITS Connection

The SEL-3031 makes it very simple to set a MIRRORED BITS connection. Only the 
PROTO setting is needed to set the MIRRORED BITS port. The SEL-3031 without an 
encryption card has fixed data rate of 19200 bps (8, N, 1) so no other setting changes 
are needed.

On Port 1 on each radio install a C285 cable to the IED device. As an alternative, the 
SEL-3031 can be ordered with a fiber-optic serial port that works with SEL-2812 
transceivers. If you use the fiber-optic port on the SEL-3031 then the IED connection 
needs to be an SEL-2812MR Fiber-Optic Transceiver.
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3.3

SEL-351, SEL-311, and SEL-700 Series MIRRORED BITS Settings
The required settings for the SEL-351 are shown below. These settings are similar to 
all of the SEL-351, SEL-311, and SEL-700 series of relays. To establish a 
communication link via the radio, the most critical settings are PROTO, SPEED, 
RTSCTS, RXID, and TXID.

=>SHO P 2 <Enter>
Port 2

PROTO = MB8A
SPEED = 19200    RTSCTS= N      RBADPU= 60       CBADPU= 1000
RXID  = 1        TXID  = 2      RXDFLT=XXXXXXXX
RMB1PU= 1        RMB1DO= 1      RMB2PU- 1        RMB2DO= 1
RMB3PU= 1        RMB3DO= 1      RMB4PU- 1        RMB4DO= 1
RMB5PU= 1        RMB5DO= 1      RMB6PU- 1        RMB6DO= 1
RMB7PU= 1        RMB7DO= 1      RMB8PU- 1        RMB8DO= 1

Figure 3.3 SEL-351 Port Settings for MIRRORED BITS Connection

The SEL-3031 locks all three serial ports to 19200 bps (8, N, 1). You cannot change the 
port speed. If the SEL-3044 Encryption Card is used then the data rate changes to 9600 
bps (8, N, 1).

NOTE: If you are using the SEL-3044 Encryption Card, you 
must change the connected devices’ RMBxPU and 
RMBxDO settings = 2 to maintain the same level of 
channel security as the standard MB8 protocol.  This will 
delay operation by one processing interval but will give 
you a higher level of channel security.

Set PROTO equal to MB8x, where x equals A or B depending on which MIRRORED 
BITS channel is used.

NOTE: This setting is slightly different in the SEL-2100 Logic 
Processor, SEL-3530 Real-Time Automation Controller 
(RTAC), and SEL-321 Relay. 

Set SPEED equal to 19200 (or 9600 if the encryption card is installed).

Set RTSCTS (hardware handshaking) to N to disable that option. 

Set the RXID equal to one and TXID equal to two at the master end. At the remote end, 
set the RXID equal to two and the TXID equal to one. The relays use these addresses to 
prevent a relay from receiving messages from a secondary MIRRORED BITS device if 
the paths are accidentally connected wrong. The relay only receives messages sent by a 
relay with the matching transmit address and vice versa. 

To connect the relay to the radio, use an SEL-C285 cable (DB-9 male-to-DB-9 male 
straight-through). If complete electrical isolation is desired between the radio and a 
relay’s EIA-232 communications port, use the SEL-2812MR Fiber-Optic Transceiver 
and fiber-optic cable to connect the relay to the radio. 
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SEL-400 Series MIRRORED BITS Settings
The required port settings for SEL-400 series relays are shown below. To establish 
communication via the radio, the most critical settings are PROTO, MBT, SPEED, 
STOPBIT, TXID, RXID, and TXMODE. All other settings are per the application 
requirements.

Protocol Selection
PROTO := MBA
Communications Settings
MBT := N SPEED :=19200 STOPBIT := 2

Mirrored Bits Protocol Setting

TX_ID := 2 RX_ID := 1 RBADPU := 10 CBADPU := 20000
TXMODE := P MBNUM := 8 RMB1FL := P RMB1PU := 1
RMB1DO := 1 RMB2FL := P RMB2PU := 1 RMB2DO := 1
RMB3FL := P RMB3PU := 1 RMB3DO := 1 RMB4FL := P
RMB4PU := 1 RMB4DO := 1 RMB5FL := P RMB5PU := 1
RMB5DO := 1 RMB6FL := P RMB6PU := 1 RMB6DO := 1
RMB7FL := P RMB7PU := 1 RMB7DO := 1 RMB8FL := P
RMB8PU := 1 RMB8DO := 1

Figure 3.4 SEL-451 Port Settings for MIRRORED BITS Connection

Set PROTO equal to MBx, where x equals A or B depending on which MIRRORED BITS 
channel is being used. Set MBT equal to N to disable that option. 

Set SPEED equal to 19200 (or 9600 if the encryption card is installed). 

Set STOPBIT equal to 2.

NOTE: If you are using the SEL-3044 Encryption Card, you 
must change the connected devices’ RMBxPU and 
RMBxDO settings = 2 to maintain the same level of 
channel security as the standard MB8 protocol.  This will 
delay operation by one processing interval but will give 
you a higher level of channel security.

Set the RXID equal to one and TXID equal to two at the master end. At the remote end, 
set the RXID equal to two and the TXID equal to one. The relays use these addresses 
so that the master relay only receives messages sent by a relay with the matching 
transmit address and vice versa. 

Set TXMODE equal to P (Paced). 

To connect the relay to the radio, use an SEL-C285 cable (DB-9 male-to-DB-9 male 
straight-through). If complete electrical isolation is desired between the radio and 
antenna and the relay’s EIA-232 communications port, use the SEL-2812MR Fiber-
Optic Transceiver and fiber-optic cable to connect the relay to the radio.
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SEL-2505 and SEL-2506 Settings
The SEL-2505 and SEL-2506 use control (DIP) switches to set the MIRRORED BITS 
connection. For easy installation order the SEL-2505 with the SEL-2812 fiber-optic 
option (SEL-2505x6xXX). Use multimode C807 ST terminated fiber-optic cable to 
directly connect the SEL-2505 to an SEL-3031 equipped with a fiber-optic option for 
Port 1. Other transceiver models can be used as long as the corresponding SEL-2800 
family transceiver is used on both ends.

Figure 3.5 SEL-2505 DIP Switch Settings for MIRRORED BITS Connection

Set the TX_ADD equal to one and set RX_ADD equal to two at the local end. At the 
remote end, set the RXID equal to two and the TXID equal to one. The devices use 
these addresses so that the master relay only receives messages sent by a relay with the 
matching transmit address and vice versa. 

Set Switch 9 and 10 equal to MB8/19200 for the Protocol/Baud setting. If the 
SEL-3031 contains the SEL-3044 Encryption Card then the Protocol/Baud setting 
must be MB8/9600.

NOTE: If you are using the SEL-3044 Encryption Card, you 
must change the settings of the SEL-2505 output contact 
mode dip switches to “SECURE” to maintain the same 
level of channel security as the standard MB8 protocol.  
This will delay operation by one processing interval but 
will give you a higher level of channel security.

To connect the SEL-2505 to the radio, use a 62.5 µm multimode SEL-C807 fiber cable. 
The SEL-C807 fiber cable comes with ST® connectors and your choice of zipcord or 
waterproof heavy-duty jacketed fibers.
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Initial Checkout
The easiest way to verify that the relays are communicating is to use the TARget 
command, as shown below.

=>TAR ROKA <Enter>
LBOKB CBADB RBADB ROKB LBOKA CBADA RBADA ROKA
0 0 0 0 0 0 0 1

Figure 3.6 TAR ROKA Command From an SEL-351

The results shown here is from an SEL-351 Relay. ROKA is asserted, meaning that the 
two relays have established MIRRORED BITS communication. For longer-term channel 
tests, use the COM report command available in the relay and suggestions described in 
Monitoring Radio Performance on page 5.1.

Using an SEL Information Processor to 
Collect Relay Status and Measurements
SEL information processors and computing platforms easily collect relay status and 
measurement information. SEL information processors include the SEL-3530 Real-
Time Automation Processor, SEL-2032, SEL-2030, and SEL-2020 Communications 
Processors, and ruggedized SEL computers configured as intelligent servers or 
gateways. An SEL information processor can be used as data collection point, port 
switch, and control operations all through one serial port. The SEL-3031 serial 
interface allows you to obtain all of this relay information from remote IEDs using the 
wireless connection. The example below will show you how to set the radio, relays, 
and communications processors to allow the Fast Messaging protocol to operate over a 
wireless connection.

Figure 3.7 SEL-3031 Linking Information Processors to Relays

SEL-351

SEL-3031SEL-3031

SEL-2032

SEL-451
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SEL-3031 Settings
The SEL-3031 requires very few inputs for setting up the serial port to the correct 
protocol. Figure 3.8 shows the settings needed for Port 1.

Figure 3.8 SEL-3031 Port 1 Settings for Fast Messaging

The PROTO setting must be set to Standard. The Standard setting is the default for 
use on any byte-oriented protocol. The Standard setting is used with connections such 
as DNP3, SEL ASCII, Compressed ASCII, Fast Operate, Fast SER, and SEL Fast 
Meter with Configuration.

The CTS1 setting should be set to Deasserted. This will deassert the control lines on 
the SEL-3031. Some protocols in devices require the control line to be in a high or low 
state to permit proper communication. For example, with DNP, some remote devices 
will not reply back to the master until the control line is deasserted. If the control line is 
asserted the DNP device is told to wait. Again, this setting is based upon how the 
vendor implemented flow control in the devices. For most all SEL products this setting 
should always be set to Deasserted.

On Port 1 on each radio install an SEL-C285 cable to the IED device. As an alternative, 
the SEL-3031 can be ordered with a fiber-optic serial port that works with the 
SEL-2812 transceivers. If you use the fiber port on the SEL-3031 connection at the 
IED needs to be an SEL-2812MR transceiver or compatible built-in port.
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SEL-300 Series Settings
The required settings for the SEL-351 are shown below. These settings are similar to 
all of the SEL-351, SEL-311, and SEL-700 family of relays. To establish a 
communication link via the radio, the most critical settings are PROTO, SPEED, BITS, 
PARITY, STOP, and RTSCTS.

=>>SHO P 2 <Enter>
Port 2

PROTO = SEL      
SPEED = 19200    BITS  = 8        PARITY= N        STOP  = 1        
T_OUT = 10       AUTO  = Y        RTSCTS= N        FASTOP= Y        

=>>

Figure 3.9 SEL-351 Port Settings for Fast Messaging

Set AUTO = Y if you want the relay to send automatic messages to indicate specific 
conditions.

Set FASTOP = Y if you want the communication processor to issue control commands 
to the relay.

SEL-2032/SEL-2030 Settings
The following steps demonstrate on how to set SEL-2032 to initially connect and 
configure an SEL-351 relay.

Step 1. Use the SEL-C285 cable to connect one of the SEL-2032 ports; this 
example uses Port 2 to Port 1 of the SEL-3031.

Step 2. Enter Access Level 2 on the SEL-2032 and issue the SET P 2 
command to configure Port 2. The SEL-2032 prompts for the type of 
device connected to the port. 

a. Enter S for the SEL IED.

b. Enter Y to autoconfigure the port.

c. Press the <Enter> key to confirm the configuration prompts.

The SEL-2032 establishes communication with the relay; 
determines the type of relay, relay ID, and communication 
data rate; and determines if the relay is capable of Fast Meter. 

d. Enter Y to save port configuration changes at the final 
prompt.

Step 3. Issue the AUTO 2 command to see what Fast Message features are 
supported by the SEL-351S. Figure 3.10 shows an example output for 
the AUTO command.
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*>>AUTO 2 <Enter>
FID: FID=SEL-351S-7-R106-V0-Z003003-D20010110
DEVICE ID: FEEDER 1
BAUD RATE: 19200
OPERATE SUPPORT: Binary (1 Breakers, 16 Remote Bits S-C-P)
LEVEL 1 PASSWORD: OTTER
COMMANDS SUPPORTED:
B 20METER
B 20DEMAND
B 20TARGET
A 20HISTORY
A 20STATUS
A 20EVENT
A 20EVENTS
A 20EVENTL
*>>

Figure 3.10 Example AUTO Command Output

The AUTO command verifies initial configuration is set up. Refer to the SEL-2032 
Instruction Manual for more information on setting up Fast Messaging.
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Settings and Commands

PC Software
ACSELERATOR QuickSet® SEL-5030 Software is a powerful settings and HMI tool 
that aids in setting, applying, and using the SEL-3031 and other SEL devices. This 
section describes how to get started with your SEL-3031 and ACSELERATOR QuickSet.

Setup
Follow the steps outlined in Section 2: Installation to prepare the SEL-3031 for use. 
Perform the following steps to initiate communications:

Step 1. Apply power to the SEL-3031.

Step 2. Connect a USB Type-B cable (SEL-C664) between the management 
port of the SEL-3031 and the PC.

Step 3. Follow the on screen instructions and install the USB driver if not 
already installed.

Step 4. Start ACSELERATOR QuickSet software.

Table 4.1 ACSELERATOR QuickSet SEL-5030 Software

Terminal Provides a direct connection to the SEL device. Use this com-
munications method to interface directly with the device.

Rules-Based Settings 
Editor

Provides online or offline device settings that include 
interdependency checks. Use this feature to create and 
manage settings for multiple devices in a database.

Settings Database 
Management

Provides a database to manage multiple device settings.

Help Provides general ACSELERATOR QuickSet and device-spe-
cific ACSELERATOR QuickSet context help.
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Communications
ACSELERATOR QuickSet uses the device USB management port to communicate with 
the SEL-3031. Perform the following steps to configure ACSELERATOR QuickSet to 
communicate effectively with the device.

Step 1. Click Communications from the ACSELERATOR QuickSet main 
menu bar, as shown in Figure 4.1.

Figure 4.1 Communications Menu

Step 2. Select Parameters to display the screen shown in Figure 4.2.
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Figure 4.2 Serial Port Communications Parameters

Step 3. Configure the PC port to Data Speed 9600, Data Bits 8, Stop Bits 1, 
and Parity None.

Step 4. Configure ACSELERATOR QuickSet to match the SEL-3031 default 
settings by entering the Access Level 1 and Access Level 2 passwords 
in their respective text boxes.

Step 5. Exit the menus by clicking OK when finished.

Terminal Window
Select Communications > Terminal on the ACSELERATOR QuickSet main menu bar 
to open the terminal window (shown in Figure 4.3).
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Figure 4.3 Terminal Window Menu

The terminal window is an ASCII interface for the device that supports a basic terminal 
emulation. Open the terminal window by clicking Communications > Terminal or by 
typing <Ctrl+T>. Verify proper communications with the device by opening a 
terminal window, pressing <Enter> a few times, and verifying that a prompt is 
received. If a prompt is not received, verify proper setup.

Drivers and Part Number
After clicking Communications > Terminal, access the device at Access Level 1. 
Issue the ID command to receive an identification report, as shown in Figure 4.4.

=>>ID <Enter>
"FID=SEL-3031-R100-V0-Z001001-D20091009","08DC"
"BFID=SLBT-3031-R100-V0-Z001000-D20091009","0965"
"CID=25DC8978","034B"
"DEVID=STATION_A","04DB"
"DEVCODE=72","0310"
"PARTNO=30310W01XXX","0538"
"CONFIG=00000000","03E3"
"SPECIAL=0”,”02DE”
=>>

Figure 4.4 Device Response to ID Command

Locate and record the Z-number (Z001001) in the FID string. The first portion of the 
Z-number (Z001...) determines the ACSELERATOR QuickSet device settings driver 
version when you are creating or editing device settings files. The Device Editor driver 
will be discussed in more detail in Device Editor (Editor Mode). Compare the part 
number (PARTNO = 3031XXXXXXX) with the Model Option Table (MOT) to ensure 
correct device configuration.
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Settings
Settings Database Management and Drivers

ACSELERATOR QuickSet uses a database on the PC to save device settings. 
ACSELERATOR QuickSet contains sets of all settings files for each device specified in 
the Database Manager. Choose appropriate storage backup methods and a secure 
location for storing database files.

Active Database
Change the active database to the one requiring modification by selecting File > Active 
Database on the main menu bar.

Database Manager
Select File > Database Manager on the main menu bar to create new databases and 
manage records within existing databases.

Settings Database
Step 1. Open the Database Manager to access the database. Click File > 

Database Manager. A dialog box will appear. The default file 
already configured in ACSELERATOR QuickSet is Relay.rdb. This 
database contains example settings files for the SEL products with 
which you can use ACSELERATOR QuickSet.

Step 2. Enter descriptions of the database for each device in the Database 
Description and Settings Description dialog boxes.

Step 3. Enter special operating characteristics that describe the device 
settings in the Settings Description dialog box. These can include 
radio location and communications settings.

Step 4. Highlight one of the devices listed in Settings in Database and click 
Copy to create a new collection of settings. ACSELERATOR QuickSet 
will prompt for a new name. Be sure to enter a new description in the 
Settings Description.

Copy/Move Settings Between Databases
Step 1. Select Copy/Move Settings Between Databases to create multiple 

databases with the Database Manager.

These databases are useful for grouping similar protection schemes or 
geographic areas.

Step 2. Click Open B to open a device database.
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Step 3. Type the filename and click Open.

a. Highlight the device or setting in the A database.

b. Select Copy or Move, and click the > button to create a new 
device or setting in the B database.

Step 4. Reverse this process to take devices from the B database to the A 
database. Copy creates an identical device that appears in both 
databases. Move removes the device from one database and places 
the device in another database.

Create a New Database/Copy an Existing Database
To create a new database, perform the following:

Step 1. Open File > Database Manager and click Create New Database. 
ACSELERATOR QuickSet will prompt you for a file name.

Step 2. Type the new database name (and location if it differs from the 
previous database location), and click Save. ACSELERATOR QuickSet 
displays the message Settings [path and file name] was 
successfully created.

Step 3. Click OK.

To copy an existing database of devices to a new database, perform the following:

Step 1. Open File > Database Manager and click Copy/Move Settings 
Between Databases in the Database Manager dialog box. 
ACSELERATOR QuickSet will open the last active database and assign 
it as Database A.

Step 2. Click Open B. ACSELERATOR QuickSet will prompt you for a file 
location. Type the new database name, click Open, and click Yes. 
The program will then create an empty database. Load devices into 
the new database as shown in Copy/Move Settings Between 
Databases.

Settings
ACSELERATOR QuickSet allows you to create settings for one or more SEL-3031 
devices. Store existing device settings downloaded from the SEL-3031 by creating a 
library of settings, then modify and upload these settings from the library to an 
SEL-3031. ACSELERATOR QuickSet makes setting the device easy and efficient and 
provides rules-based settings checks, commissioning, and help.

Settings Editor
The Settings Editor shows device settings in easy-to-understand categories. and makes 
setting the device simple and efficient. Settings are grouped logically, and settings that 
are not used in the selected group are dimmed (grayed) in the ACSELERATOR QuickSet 
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menus. ACSELERATOR QuickSet shows all of the settings categories in the settings tree 
view. The settings tree view remains constant whether settings categories are enabled 
or disabled. However, any disabled settings are dimmed when accessed by clicking an 
item in the tree view.

File Menu
ACSELERATOR QuickSet uses a database to store and manage SEL device settings. 
Each unique device has its own record of settings. Use the File menu to open an 
existing record, create and open a new record, read device settings, create an open a 
new record, or convert and open an existing record. This record can be opened in the 
Settings Editor as a Setting Form (template) or in Editor Mode.

File > New
Select File > New to command new settings files. ACSELERATOR QuickSet will create 
the new settings files from a driver that you specify in the Settings Editor Selection 
dialog box. ACSELERATOR QuickSet uses the Z-number in the FID string to create a 
particular version of settings. To get started, select File > New from the main menu bar, 
then select SEL-3031 and 001 from the Settings Editor Selection window as shown in 
Figure 4.5.

Figure 4.5 Selection of Drivers

After you select the device model and settings driver, ACSELERATOR QuickSet will 
present the Device Part Number dialog box. Use this dialog box to configure the 
Device Editor to produce settings for your device with options determined by the part 
number, as shown in Figure 4.6. Click OK when finished.
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Figure 4.6 Update Part Number

Figure 4.6 shows the Settings Editor screen. View the bottom of the Device Editor 
window to verify the Settings Driver number. Compare the ACSELERATOR QuickSet 
Settings Driver number and the first portion of the Z-number in the FID string (this can 
be found by selecting Tools > HMI > HMI > Status). These numbers must match. 
ACSELERATOR QuickSet uses the first portion of the Z-number to determine which 
Device Editor to display.

Figure 4.7 New Setting Screen

File > Open
Select File > Open to open an existing device from the active database folder. 
ACSELERATOR QuickSet prompts for a device to load into the Device Editor.
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File > Read
Select File > Read to cause ACSELERATOR QuickSet to read the device settings from a 
connected device. As ACSELERATOR QuickSet reads the device, a Transfer Status 
window will appear. ACSELERATOR QuickSet uses serial protocols to read settings 
from SEL devices.

Device Editor (Editor Mode)
Use the Device Editor (Editor Mode) to enter and display settings. Make sure that the 
firmware in your radio matches the ACSELERATOR QuickSet settings driver; the driver 
version number in the lower left corner of the Device Editor should be equal to the first 
three digits following “Z” in the radio Firmware Identification (FID) string. Use the ID 
or STA command to easily view the FID string.

Entering Settings
Step 1. Click + in the Settings Tree View to expand and select the settings 

you want to change.

Step 2. Click Tab to navigate through the settings, or click on a setting.

Step 3. Right-click your mouse in the setting dialog box and select Previous 
Value to restore the previous value for a setting.

Step 4. Right-click your mouse in the setting dialog box and select Default 
Value to restore the factory default setting value.

If you enter a setting that is out of range or has an error, ACSELERATOR QuickSet will 
show the error at the bottom of the Settings Editor. Double-click the error listing to go 
to the setting and enter a valid input.

Sending Settings
Select Save, Send, or Print Device Settings from the File menu of the Device Editor 
once settings are entered into ACSELERATOR QuickSet. This will ensure that your 
settings are not lost.

Table 4.2 Device Editor Menus

Menus Description

<< >> Moves from one category to the next.

Merge Merges the open record with another record.

Compare Compares the open record with another record.

Search Searches for a particular setting.

Part Number Displays part number.
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Options—Part Number
Select Edit > Part Number to change the part number if it was entered incorrectly 
during an earlier step.

Text Files
Select Tools > Settings > Import or Tools > Settings > Export on the Device Editor 
(Editor Mode) menu bar to import or export settings to or from a text file. Use this 
feature to create a small file that can be easily stored or sent electronically.

Meter and Control
Human Machine Interface (HMI)

Select Tools > HMI > HMI to bring up the screen shown in Figure 4.8. The HMI tree 
view shows the functions that are available from the HMI. The Meter & Control 
window is an easily-organized view of real-time data and information stored in the 
SEL-3031.

Figure 4.8 Status Screen

The Status screen provides a real-time view of the radio to which it is connected. A 
user can see the current status of the SEL-3031 and verify any alarm conditions.

Select the Radio Status screen to view the radio statistics. Included is the RSSI value 
that displays the current strength of the receive signal. This will aid in properly aiming 
the antenna for maximum signal strength. The “Availability” displays the overall 
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channel availability of the link. The “Zone Availability” gives the availability of each 
of the 10 zones. See Monitoring Radio Performance on page 5.1 for more information 
on optimizing the radio link.

Figure 4.9 Radio Strength and Channel Availability

The SER window displays the same information as the ASCII SER commands. The 
Control Window allows you to clear the SER, synchronize with IRIG, and set the time 
and date.

Global Settings
Under the Global group settings category, set the device and host identifiers settings. 
The SEL-3031 displays the Device and Host Identifier strings at the top of the serial 
port commands responses, identifying messages from individual devices. Enter up to 
30 characters, including capital letters A–Z, numbers 0–9, periods, and dashes. 
Table 4.3 shows the device and host identifier settings.

Table 4.3 Global Settings

Setting Prompt Setting Range Setting Name := Factory Default

Device Identifier 30 characters DID

Host Identifier 12 characters (no spaces) HID

Date Format MDY, YMD, DMY DATE_F := MDY

Port Power ON, OFF 5V_EN := OFF
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Date_F allows you to change the device date presentation format to either North 
American standard (Month/Day/Year), Engineering standard (Year/Month/Day), or 
European standard (Day/Month/Year).

5V_EN enables the +5 V on Pin 1 on every EIA-232 DB-9 serial port. When this 
setting is on, all three ports will have +5 Vdc on Pin 1. The entire load on the +5 V 
must not exceed 500 mA.

Radio Settings

MODE sets the operating mode of the radio. The radio is set to REMOTE by default. 
One radio must be set to REMOTE and the other set to MASTER.

NID sets the network address of the radio network. Both radios must be set to the same 
network address in order for them to link and communicate. If more than one radio 
network is used in the same proximity then make sure that the NID is set to a different 
value and SKIP the first six zones on one of the radio networks. To avoid certain radio 
frequencies, see setting SKIP.

SKIP determines which of the 16 frequency zones to skip in the SEL-3031 hopping 
sequence. The SEL-3031 will only operate on 10 of the 16 zones. The default setting is 
set to NONE. The SEL-3031 must use a minimum of 10 zones, so a setting of NONE 
will force the radio automatically SKIP zones 11–16. The SKIP setting can contain up 
to six comma-delimited zones from Table 4.5. Each zone entered into this setting will 
set the SEL-3031 to skip that particular zone in the hopping table. This setting can help 
increase the availability of the radio and avoid areas of interference.

Table 4.4 Radio Settings

Settings Prompt Settings Range Setting Name := Factory Default

Operation Mode MASTER, REMOTE MODE := REMOTE

Network Identification 1–10 NID := 1

Skip Zones 1–16, NONE SKIP := NONE

Transmit Power 20–30 dB TXPWR := 30

Encryption Passphrase 8–80 Characters KEY := NONE

Table 4.5 SKIP Zone Frequencies

Zone 1 Zone 2 Zone 3 Zone 4 Zone 5 Zone 6 Zone 7 Zone 8

902.6–
903.8

904.1–
905.3

905.6–
906.8

907.1–
908.3

909.2–
910.4

910.7–
911.9

912.2–
913.4

913.7–
914.9

Zone 9 Zone 10 Zone 11 Zone 12 Zone 13 Zone 14 Zone 15 Zone 16

915.2–
916.4

916.7–
917.9

918.2–
919.4

919.7–
920.9

921.2–
923.0

923.3–
924.5

924.8–
926.0

926.3–
927.5
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The SEL-3031 has radio statistics to help set the SKIP setting if the availability of the 
radio is less than desired. In order to determine which frequency zones to skip, issue a 
RADio C command and operate the radios over a period of time. You will get better 
availability results the longer you let the radio run linked. Issue the RADio command 
to view the availability of each frequency zone. In the radio report identify the 
frequency zones with the lowest availability and enter these zones via the SKIP setting. 
Issue another RADio C command and let the SEL-3031 run for another day and verify 
that the availability has increased. See Section 5: Performance Monitoring, Testing, 
and Troubleshooting for more information on how to use the SKIP setting.

TXPWR sets the transmitted power out of the SEL-3031. The available range is 
20–30 dBm (1 W). The radio transmit power is set in 1 dBm increments. The radio is 
shipped with a factory default setting of 30 dBm. This setting must be used to reduce 
the power output of the antenna if the total EIRP exceeds 36 dBm. See Transmitted 
Signal on page 2.3 for more information on how to calculate and configure the 
maximum power output.

In the USA and Canada, the FCC and IC regulate the amount of power a radio can 
radiate with EIRP (Effective Isotropically Radiated Power output). The EIRP limit of 
radiation is 36 dBm. This value includes the power of the transmitter, cable losses, and 
antenna gain. If you exceed the allowed 36 dBm you must lower the transmitted power 
of the radio using the TXPWR setting, and then measure the actual power.

See Transmitted Signal on page 2.3 for more information on determining and properly 
setting the TXPWR setting.

The KEY setting is only available if the product contains an SEL-3044 Encryption 
Card. The KEY setting is a passphrase that is used to generate an encryption key. The 
acceptable range is from 8 to 80 characters. All printable characters are accepted. If 
you have an encryption card, this value must be set in order to enable the secure 
wireless connection. When the SEL-3031 is shipped with the encryption card, or added 
in the field, it is by default shipped in reset mode. The SEC LED on the front panel will 
flash green to show this state. The KEY setting must be set in order to activate the 
encryption card. The SEL-3031 radios will not transmit data until the SEL-3044 is set 
properly. The SEC LED will illuminate green when the KEY setting is correctly set. The 
green SEC LED indicates data being set through the radio link is secured. Once the KEY 
setting is configured the setting can never be read back, viewed, or saved with 
ACSELERATOR QuickSet software.

To encrypt a radio link, both radios must contain an SEL-3044 and the KEY settings 
must be set to the same value. See Appendix B: SEL-3044 Encryption Card for more 
information on the SEL-3044 Encryption Card.

Port Settings
The SEL-3031 settings allow you to configure the parameters for each of the three 
communications ports. The SEL-3031 comes standard with three EIA-232 ports. Port 1 
can be ordered as an EIA-232, EIA-485, or serial fiber-optic port. Table 4.6 shows the 
port settings ranges and default settings for Port 1, Port 2, and Port 3.
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The protocol setting defines the type of data that will be passing through the serial port. 
This setting automatically sets parameters in the radio to optimize best performance. 
Any of the three serial ports may be set to any of the protocols. Ports 2 and 3 are always 
EIA-232 ports. For example, you have three ports of MIRRORED BITS® (MB8), or any 
combination or MB8, MODBUS, and STANDARD.

PROTO sets the intended protocol used to communicate through the radio ports. Set to 
STANDARD for all byte-oriented protocols such as DNP3, ASCII, Synchrophasors, or 
file transfer. This is the default setting for PROTO and should be used unless you are 
using MIRRORED BITS or MODBUS. Set PROTO to MB8 to work with SEL 
MIRRORED BITS devices. The SEL-3031 only supports MB8 MIRRORED BITS protocol. 
See Section 3: Job Done Examples for more information on setting up MIRRORED 
BITS. Set PROTO to MODBUS when used with Modbus protocol. When PROTO is set 
to either STANDARD or MODBUS the radio will not perform the 32-bit CRC check 
on the received data. If you do not have a good link with high availability you will see 
noise on the channel. These errors are better handled by the communications protocols 
to ignore this data rather than have conflicting retry messages between the radio and 
communications protocols.  If PROTO is set to MB8, the 32-bit CRC will remove any 
data that does not pass the CRC. The data rate on all three ports is fixed at 19200 bps. If 
the unit has an SEL-3044 Encryption Card then the data rate is fixed at 9600 bps.

NOTE: If you are using the SEL-3044 Encryption Card and 
PROTO is equal to MB8 you must change the connected 
devices’ RMBxPU and RMBxDO settings = 2 to maintain 
the same level of channel security as standard MB8 
protocol. This will delay operation by one processing 
interval but will give you a higher level of channel 
security.

Table 4.6 Port Xa Settings 

a. X = 1, 2, or 3.

Settings Prompt Settings Range Setting Name := Factory Default

Protocol STANDARD, MB8, MODBUS PROTO := STANDARD

CTS State Asserted, Deasserted CTS := DEASSERTED

Echo ON, OFF ECHO := OFF
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The CTS setting is used to set the state of the CTS (Pin 7) line on each of the ports. In 
most cases this setting should be set to deasserted. Most SEL devices require CTS 
deasserted in order for them to respond to DNP requests. The SEL-3031 does not 
support hardware flow control. It will only assert or deassert the CTS line to signal 
connected equipment to continue communication.

The ECHO setting is only enabled when Port 1 is ordered as an EIA-485 device. This 
setting is used to set up a two-wire versus four-wire EIA-485 connection. The default 
ECHO setting is set to ON which works with four-wire EIA-485 applications. For two-
wire operation, the ECHO setting must be set to OFF, and Pins 1 and 7 and Pins 2 and 
8 must be connected together (see Table 2.9).

Commands
Access Levels

Issue commands to an SEL-3031 serial port to view or change device settings or 
retrieve information. For security, these commands are available on different password-
protected access levels. Throughout this section each command description indicates 
the access level at which the command is available. There are three access levels in the 
device, offering varying levels of control.

➤ Access Level 0 commands are the lowest security level. Access 
Level 0 commands support minimum identification.

➤ Access Level 1 commands are for reviewing information only (e.g., 
status) and not for making any changes.

➤ Access Level 2 commands are for changing device settings.

Go to Communications on page 4.2 for instructions on connecting to the SEL-3031 
through the USB interface.

The virtual serial interface created from the USB port must be set to 9600 bps, 8 data 
bits, 1 stop bit, and no parity to communicate to the SEL-3031.

Table 4.7 Fixed Port Settings

Port Setting Fixed Port Settings
Fixed Port Settings With 
SEL-3044 Card

Data Rate 19200 bps 9600 bps

Data Bits 8 8

Parity None None

Stop Bit 1 1

RTS/CTS Flow Control Off Off
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Access Level 0
Once serial port communication is established with the SEL-3031, press <Enter> and 
you should see the following prompt:

=

NOTE: If you don't get the = prompt, then refer back to 
Communications on page 4.2 to properly connect to the 
SEL-3031.

This is referred to as Access Level 0. Only a few commands are available at this level. 
One is the ACC command.

Enter ACC at the Access Level 0 prompt:

=ACC <Enter>

The ACC command takes the SEL-3031 to Access Level 1.

Access Level 1
When the SEL-3031 is in Access Level 1, the device sends the following prompt:

=>

From Access Level 1, use the 2AC command to go to Access Level 2. 

Enter 2AC at the Access Level 2 prompt:

=>2AC <Enter>

Access Level 2
When the device is in Access Level 2, the SEL-3031 sends the following prompt:

=>>

All of the Access Level 1 commands are available in Access Level 2. The SEL-3031 
responds with Invalid Access Level when a command is entered from an access 
level lower than the required level for the command. The device responds with 
Invalid Command to commands that are not available or are entered incorrectly.
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ASCII Commands
The SEL-3031 includes ASCII commands and settings to properly set the SEL-3031. 
ACSELERATOR QuickSet software provides a user-friendly interface to set the 
SEL-3031, but either interface can be used to set the product.

DATE Command
Use the DATE command to view and set the date, as shown in Table 4.8.

The device can overwrite the date entered with other time sources, such as IRIG. Enter 
DATE to set the internal clock date. Separate the month, day, and year parameters with 
slashes. Set the year in four-digit format (for dates 2000–2099).

IDENTIFICATION Command
The ID command extracts device identification codes, as shown in Table 4.9. The ID 
command is only available as a compressed (comma-delimited) command.

IRIG Command
Use the IRI command to read the demodulated IRIG-B time code at the management 
port or IRIG-B input, and to force immediate synchronization of the internal clock with 
the IRIG-B signal (see Table 4.10). If an IRIG-B signal is present at serial Port 2, the 
device will automatically synchronize the internal clock with the IRIG-B signal in a 
time period not exceeding one minute. It is not necessary to issue the IRI command for 
this automatic synchronization. If you are testing the device and do not want to wait for 

Table 4.8 DATE Command

Command Description Access Level

DAT Displays the internal clock date. 1

DAT date Sets the internal clock date (DATE_F set to MDY, 
YMD, or DMY).

1

Table 4.9 ID Command

Command Description Access Level

ID Returns a list of device identification codes, as shown 
below:

=ID <Enter>
"FID=SEL-3031-R100-V0-Z001001-D20091009","08D2"
"BFID=SLBT-3031-X307-V0-Z000000-D20091009","0974"
"CID=2B957901","0330"
"DEVID=RADIO 1","03D9"
"DEVCODE=72","0310"
"PARTNO=30310W01XXX","0538"
"CONFIG=00000000","03E3"
"SPECIAL=0","02DE"

1
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the one-minute synchronization, issue the IRI command to force the device to 
synchronize immediately with the IRIG-B signal. You can also use the IRI command 
to determine whether the device is properly reading the IRIG-B signal.

t

To force the device to synchronize to IRIG-B, enter the following command:

=>IRI <Enter>

If the device successfully synchronizes to IRIG-B, it will send the following header 
and access level prompt:

SEL-3031                     Date: 04/12/2005   Time: 15:41:29
DEVICE
=>

If no IRIG-B code is present at the serial port input, or if the code cannot be read 
successfully, the device will respond as follows:

IRIG-B DATA ERROR
=>

L_D Command
Use L_D to load firmware, as shown in Table 4.11. See Appendix A: Firmware and 
Manual Versions for information on firmware and instruction manual changes.

Table 4.10 IRIG Command

Command Description Access Level

IRI Forces synchronization of internal control clock to 
IRIG-B time-code input.

1

Table 4.11 L_D Command

Command Description Access Level

L_D Downloads firmware to the device. 2
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PASSWORD Command
Use PAS to view or change existing passwords, as shown in Table 4.12 and Table 4.13.

This device is shipped with default passwords. Default passwords should be 
changed to private passwords at installation. Failure to change each default 
password to a private password may allow unauthorized access. SEL shall not 
be responsible for any damage resulting from unauthorized access.

! WARNING

To change the password for Access Level 2 from the default password TAIL to new 
password Ot3579, enter the following:

=>>PAS 2 <Enter>
Old PW:? **** <Enter> (Enter TAIL)
New PW:? ******* <Enter> (Enter Ot3579)
Confirm PW:? ******* <Enter> (Enter Ot3579)
Password Changed

CAUTION: This password can be strengthened. Strong passwords do not include a name, date, 
acronym, or word. They consist of the maximum allowable characters, with at least one special 
character, number, lower-case letter, and upper-case letter. A change in password is 
recommended.
=>>

Similarly, use PAS 1 to change Access Level 1 passwords. Passwords can contain as 
many as 12 characters. Uppercase and lowercase letters are considered different 
characters. Strong passwords have 12 characters with at least one special character or 
digit and mixed-case sensitivity, and do not form a name, date, acronym, or word. 
Passwords formed in this manner are less susceptible to password guessing and 
automated attacks. Examples of valid, distinct, strong passwords are shown below.

➤ #Ot3579!ljd7

➤ $A24.68&,mvj

➤ (Ih2dcs)36dn

➤ *4u-Iwg+?lf-

Table 4.12 PAS Command

Command Description Access Level

PAS level new passwords Sets a password for new password for 
Access Level level.a

a. Parameter level represents the device Access Levels 1 or 2.

2

Table 4.13 Factory Default Passwords

Access Level Password

1 OTTER

2 TAIL
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If you forget your password, you can reissue a new password by following these steps:

Step 1. In accordance with the appropriate safety regulations, turn off the 
device, and see Front-Panel Jumpers on page 2.9 for instructions on 
accessing the jumpers.

Step 2. Go to Table 2.5 to locate Jumper 2 and short the jumper as shown.

Step 3. Go to the appropriate access level and issue PAS x (x = 1 or 2) to 
enter a new password.

Step 4. In accordance with the appropriate safety regulations, turn off the 
device and remove Jumper 2 to activate the password function.

Step 5. Replace the front-panel cover and turn on the device.

QUIT Command
Use QUIT to revert to Access Level 0 from either Access Level 1 or 
Access Level 2, as shown in Table 4.15.

Access Level 0 is the lowest access level; your SEL-3031 does not require a password 
check to descend to this level (or to remain at this level).

RADIO Command
The RAD command is for viewing statistics and data on the radio link, as shown in 
Table 4.16. The RAD command provides two important types of information.

➤ RSSI = Receive Signal Strength Indicator. The RSSI shows the 
current strength of the receive signal from the radio. This command 
helps you to refine antenna positioning. The RSSI is reported in dBm 
and updates every time the RAD command is issued. The RSSI is 
calculated from the latest 50 frequency hops averaged over time. 
RSSI is very useful for optimizing performance on directional 
antennas and monitoring signal strength.

Table 4.14 Valid Password Characters

Alpha
A B C D E F G H I J K L M N O P Q R S T U V W X Y Z

a b c d e f g h i j k l m n o p q r s t u v w x y z

Numeric 0 1 2 3 4 5 6 7 8 9

Special ! “ # $ % & ‘ ( ) * + , - . / : ; , = . ? @ [ \ ] ^ _ ‘ { | } ~

Table 4.15 QUIT Command

Command Description Access Level

QUI Sends you to Access Level 0. 0
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➤ AVAILABILITY. The radio automatically calculates the availability 
of the overall radio link and the availability of each hopping 
frequency. The availability is calculated by measuring the number of 
good radio frames received per the number of radio frames expected. 
The Overall is the tallied availability of each of the frequency zones 
used in the current hopping table. This number is valuable for 
measuring overall radio availability. The SEL-3031 also calculates 
the availability of each zone used in the current hopping table. The 
radio zones displayed in the RAD command are based on the SKIP 
setting. See Table 4.5 for more information on Skip Zones. See 
Section 5: Performance Monitoring, Testing, and Troubleshooting for 
more information on using the availability to set the SKIP setting for 
improved radio performance.

1         2         3         4         5         6         7         8
12345678901234567890123456789012345678901234567890123456789012345678901234567890
[Common Header]

RSSI
 -69 dBm

AVAILABILITY:        From 10/02/2009 17:33:21

Overall
100.00 %

Zone  1     Zone  2     Zone  3     Zone  4     Zone  5
100.00 %    100.00 %    100.00 %    100.00 %    100.00 %

Zone  6     Zone  7     Zone  8     Zone  9     Zone 10
100.00 %    100.00 %    100.00 %    100.00 %    100.00 %

Figure 4.10 RAD Command Response

Table 4.16 RAD Command

Command Description Access Level

RAD View radio statistics 1

RAD C Clear radio statistics 2
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SER Command
Use SER to view and manage the Sequential Events Recorder report, as shown in 
Table 4.17.

If the requested SER report rows do not exist, the device will respond with the 
following:

NO SER data

SET Command
The SET command is for viewing or changing device settings, as shown in Table 4.18. 
Append TERSE to skip the settings display after the last setting. Use this parameter to 
speed up the SET command. If you want to review the settings before saving, do not 
use the TERSE option.

Append the specific setting name you want to change in the SET command to 
immediately jump to the setting. If s is not entered, the device starts at the first setting. 
For example, to directly jump to the TXPWR setting in the Radio setting category, 
enter SET R TXPWR <Enter>. This will take you directly to the TXPWR setting. 

Table 4.17 SER Command

Command Description Access Level

SER Displays a chronological progression of all avail-
able SER rows (up to 1024 rows); row 1 is the 
most recent and row 1024 is the oldest.

1

SER row 1

SER row 1 row 2

SER date 1

SER date 1 date 2

Displays a chronological or reverse chronological 
subset of the SER rows.

1

SER C Clears/resets all SER records. 2

Table 4.18 SET Command (Change Settings)

Command Description Access Level

SET G sa

a. s = specific setting name.

Set Global settings 2

SET R s Set Radio settings 2

SET P s Set serial Port settings 2
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If you want to set all of the Radio settings, issue the SET R command and it will start 
at the beginning of the settings list. Enter the desired setting value or press <Enter> to 
accept the existing setting, as shown in Table 4.19.

The device checks each setting to ensure that it is within the allowed range. If the 
setting is not within the allowed range, the device generates an Out of Range 
message and prompts you for the setting again. When all the settings are entered, the 
device displays the new settings and prompts you for approval to enable them. Answer 
Y <Enter> to enable the new settings. The device is disabled for no longer than one 
second while saving the new settings. The ALARM LED illuminates momentarily and the 
ENABLED LED extinguishes while the device is disabled.

SHOW Command
When showing settings, the radio displays the settings label and the present value from 
nonvolatile memory for each setting class as shown in Table 4.20.

Append s and the specific settings name you want to view in the SHOW command to 
immediately jump to the setting. If s (and the settings name) is not included, the device 
presents settings beginning with the first in the group.

Table 4.19 SET Command Editing Keystrokes

Press Key Results

<Enter> Retains the setting and moves to the next setting.

^<Enter> Returns to the previous setting.

< <Enter> Returns to the previous setting category.

> <Enter> Moves to the next setting category.

END <Enter> Exits the editing session, then prompts you to save the settings.

<Ctrl+X> Aborts the editing session without saving changes.

Table 4.20 SHO Command (Show/View Settings)

Command Description Access Level

SHO G s Show Global settings 1

SHO R s Show Radio settings 1

SHO P s Show serial Port settings 1
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STATUS Command
Use STA to display the status report, as shown in Table 4.21.

Refer to Section 5: Performance Monitoring, Testing, and Troubleshooting for self-test 
thresholds and corrective actions, as well as information on hardware configuration 
conflict resolution. Figure 4.11 shows the device response to the STA command.

=>>STA <Enter>
RADIO 1                                  Date: 10/10/2009   Time: 16:44:00
STATION_A                                Time Source: Internal

Serial Number: 2009275250
FID=SEL-3031-R100-V0-Z001001-D20091009 CID=25D052CF
RFID=SEL-3031-R100-V0-D20091009
BFID=SLBT-3031-R100-V0-Z000000-D20091009
Part number 30310W01XXX

PROTOCOLS

PORT 1 PORT 2 PORT 3
STANDARD MODBUS MB8

SELF TEST RESULTS

FLASH      SDRAM       RADIO       RTC       SEC
OK OK OK OK ABSENT

Device Enabled

Figure 4.11 Device Response to the STATUS Command

Table 4.22 shows the status report definitions and message formats for each test.

Table 4.21 STA Command (Device Self-Test Status)

Command Description Access Level

STA n Displays the device self-test information n times 
(n = 1–32767). Defaults to 1 if n is not specified.

1

STA C Reboots the device and clears self-test warning and 
failure status results.

2

Table 4.22 STA Command Report (Sheet 1 of 2)

Status Report 
Designator

Definition Message Format

FID Firmware identifier string Text Data

RFID FPGA Firmware identifier string Text Data

BFID SELBOOT Firmware identifier string Text Data

Part Number Part Number of the SEL-3031 Text Data

PORT 1, 2, 3 Protocol setting for port 1, 2, and 3 STANDARD, MB8, MODBUS
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TIME Command
Use TIME to return information about the SEL-3031 internal clock, as shown in 
Table 4.23. You can specify hours and minutes (seconds data are optional). Separate 
the hours, minutes, and seconds with colons, semicolons, spaces, commas, or slashes.

t

Enter TIME hh:mm and TIME hh:mm:ss to set the internal clock time. The value hh 
is for hours 0–23; the value mm is for minutes 0–59; the value ss is for seconds 0–59. If 
you enter a valid time, the device will update, save the time in nonvolatile memory, and 
display the time entered. If you enter an invalid time, the SEL-3031 will respond with 
Invalid Time.

FLASH Nonvolatile memory integrity OK/FAIL

SDRAM Integrity of code that runs in RAM OK/FAIL

RADIO Radio module status OK/FAIL

RTC Real-Time Clock status OK/FAIL

SEC SEL-3044 Encryption Card status OK/ABSENT/RESET/FAIL

Table 4.23 Command Definitions

Command Description Access Level

TIME Displays the present internal clock time. 1

TIME hh:mm Sets the internal clock to hh:mm. 1

TIME hh:mm:ss Sets the internal clock to hh:mm:ss. 1

Table 4.22 STA Command Report (Sheet 2 of 2)

Status Report 
Designator

Definition Message Format
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Section 5
Performance Monitoring, Testing, 

and Troubleshooting

Overview
This section provides information on monitoring radio performance, testing, and 
troubleshooting. Because the SEL-3031 is equipped with extensive self-tests, 
traditional periodic test procedures may be eliminated or greatly reduced.

Monitoring Radio Performance
This section describes the tools you can use to monitor and improve the radio 
performance. This section assumes that the radio link is up and running in service. 
There are several items that you can use to optimize the radio link. The first section 
explains how to optimize standard radio links using DNP3, Modbus®, or other byte-
oriented protocols. The second section addresses monitoring the radio performance 
when using MIRRORED BITS®.

Monitoring and Improving Radio Link Performance
This section assumes the radio link is up and running with sufficient link availability. If 
the radio link is either not working or has very low availability view Section 2: 
Installation for information on properly installed and operating the radio.

Obtain access through the front USB port either with a terminal program or 
ACSELERATOR QuickSet® SEL-5030 Software. Access Level 1 and issue the RAD 
command (see Figure 5.1). The first value from the report is the RSSI receive signal 
strength indication. This is the level of received level strength of the radio given in 
dBm. A good radio link should have 20 dBm of margin to account for environmental 
conditions and signal fade. The SEL-3031 receiver is rated at –97 dBm. If you observe 
a value of –77 dBm or greater then you are receiving a strong signal. If the value is less 
than –77 dBm that does not mean the radio link will not work; it means that the 
performance and channel availability needs to be monitored. To increase the signal or 
availability numbers the radio antenna may need to be adjusted, output power 
increased, antenna replaced with a with a higher gain antenna, (not to exceed transmit 
power of 36 dBm EIRP), or the SKIP setting used to avoid zones with low availability. 
A path study should always be done before the radio is installed. The RSSI value 
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should match to the results of the path study. If the path study numbers do not match 
the actual results then either the data entered is incorrect or information about the 
locations was omitted. Contact SEL if you cannot get the calculated values to match 
the measured values.

RADIO 1                                  Date: 09/11/2009   Time: 10:54:26
STATION_A                                Time Source: Internal

RSSI
 -46 dBm

AVAILABILITY:        From 09/11/2009 10:53:50

Overall
100.00 %

Zone  1     Zone  2     Zone  3     Zone  4     Zone  5
100.00 %    100.00 %    100.00 %    100.00 %    100.00 %

Zone  6     Zone  7     Zone  8     Zone  9     Zone 10
100.00 %    100.00 %    100.00 %    100.00 %    100.00 %

Figure 5.1 Example RAD Command

If you are using directional antennas, verify they have identical orientation—both sides 
must be either polarized horizontally or vertically. Typically, a vertically polarized 
antenna will give better results than a horizontally polarized antenna. If the location of 
the radio antenna is shared with other antennas operating at the same frequency, then 
proper spacing and opposite polarization should be used on one set of the antennas, 
along with using the SKIP setting. See Section 2: Installation for more information on 
antenna installation. Check the aiming of the antenna while updating the RAD 
command until you get the strongest signal. This will require two people, where one 
person is moving the position of the antenna in small increments, while the other is 
monitoring the RSSI. The antenna position must be rotated on both sides to obtain the 
highest signal strength. The RSSI must also be reviewed on each radio. The receive 
strength on the remote radio will likely be different than the received strength on the 
master radio.

The last step to check is the availability of the radio link. The RAD command will give 
the overall availability of the radio link. For protection systems the desire is to have a 
radio link with 99.99% availability. This overall availability number is a great way of 
directly obtaining this number. If you are running MIRRORED BITS then you can also 
use the end devices for the availability number. 

To get a good availability reading, issue a RAD C command from Access Level 2. This 
will reset all of the availability numbers. Let the radio link run for a couple of days or 
longer. The longer period of time, the more accurate the numbers. After a few days 
have passed issue the RAD command and view the availability numbers. If the overall 
availability number is less than desired then look at the availability numbers per zone. 
If all of the zones are down in availability then more adjustment is needed on the 
antennas. If a few of the zones are down and the rest are acceptable then go back to the 
radio settings and change the SKIP zone setting. Enter the zones, up to six, that you 
want to skip with the lowest availability. Issue a RAD C command and let the radio run 
for a couple of days.
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You may need to repeat these steps before the availability reaches the desired level. 
Note: There are 16 zones available in the SEL-3031 where a radio link only uses a 
maximum of 10 zones. Skipping zones will turn on zones not previously used and may 
give worse performance. The default SKIP setting of NONE will make the SEL-3031 
SKIP zones 11–16.

If the availability of most of the zones is bad (low) and positioning the antenna did not 
help then the radio link has a large amount of interference or there is an obstruction to 
the Fresnel zone that is causing reflection issues. The interference can be caused by a 
number of items. A path study is critical to determine how good the line-of-sight is and 
how high the antennas need to be. If the path study results do not match your actual 
results you will need to make sure all of the parameters used to make the path study 
were correct. If the results still do not match then there is an unaccounted obstruction 
in the path (either buildings or trees) that is causing the decrease in availability. View 
Section 2: Installation for more information on properly installing the antenna. If the 
availability numbers are less than desired then the problem is within the location, 
interference, or multipath radio issues.  If the antenna tower is not located high enough 
and proper steps are not done to detect noise floors or obstructions to the fresnel zone 
then the availability numbers may not reach those used in the path study.

Monitoring MIRRORED BITS Performance
When using one, two, or three ports of the SEL-3031 for MIRRORED BITS 
communications it is important to monitor the availability of the channel. The 
SEL-3031 provides channel availability information and the MIRRORED BITS devices 
each contain communications data for each MIRRORED BITS channel. This section 
describes how these work and how to optimize the MIRRORED BITS channel to achieve 
a high level of availability.

The end of the previous section describes how to measure the availability of the radio 
link. All SEL relays that have MIRRORED BITS give a full channel monitoring report 
that will give the unavailability and a report on all of the data drops. The SEL-3031 
displays the availability and SEL MIRRORED BITS devices display the unavailability. 
The relationship of the two is represented below.

Availability = 1 – Unavailability

The SEL-3031 will show a lower availability than shown by the SEL relays with 
MIRRORED BITS. The difference lies in how the radio monitors each packet of 
MIRRORED BITS. Upon detecting bad packets the SEL-3031 removes the packets 
before they reach the relay. The relay will only declare a dropped channel if it receives 
bad data or after a period of time expires without seeing a new data packet. This gives 
the SEL-3031 a chance to ride through several bad hops, remove corrupted data, keep 
the channel up and operating, and minimize the amount of total unavailability as seen 
by the MIRRORED BITS devices.

Before you use an SEL device’s MIRRORED BITS communications report, make sure 
you go through Monitoring and Improving Radio Link Performance to verify the radio 
is optimized and the SKIP setting is set to avoid noisy zones. 
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Monitoring MIRRORED BITS performance over a radio link is critical to ensure proper 
operation when called upon to operate. The RBAD and CBAD bits provided in every 
SEL device with MIRRORED BITS can be used to alarm when the radio link is degraded 
below levels needed for proper operation. 

➤ RBADPU: Setting for the amount of time the channel is in a failed 
state before setting the RBAD alarm Relay Word bit.

➤ CBADPU: Setting for the threshold of the CBAD channel availability 
alarm.

When a MIRRORED BITS channel is operating correctly, Relay Word bit ROK is set to 
1. When the channel is disturbed, ROK drops out. The ROK bit is not recommended 
for use as an alarm point. ROK is a good indication of the channel’s health. If the ROK 
bit is toggling, this is an indication of an intermittent channel problem.

Figure 5.2 RBAD Generation

The RBAD bit is generated by the output of the RBAD timer. The RBAD timer is 
driven by the ROK signal. RBAD is the recommended bit to indicate communications 
alarms. Typically, a communications outage of two seconds or greater is considered an 
alarm condition. RBAD should be set on both MIRRORED BITS device to the maximum 
length of outage before declaring an alarm.

The CBADPU setting is generated from the unavailability of the MIRRORED BITS 
channel. For example, if RBADPU is set to 2 seconds and the longest channel 
disruption was 1 second out of every second and this occurred every 2 seconds, RBAD 
would not assert. RBAD would not assert because MIRRORED BITS is not disrupted for 
longer than 2 seconds at any time. Relay Word bit CBAD and the CBADPU setting 
solves this problem. To set CBADPU there are two good options. The first option is to 
set it to 2000. This is a common value used based upon spread spectrum radio use in 
the field. The CBAD Relay Word bit will assert when the unavailability of the channel 
exceeds 0.02.

The other method in setting CBAD is to let the radio link run for a period of time and 
monitor the performance. After reviewing a month of unavailability you will be able to 
set CBADPU above the unavailability value.

The proper setting and use of CBAD and RBAD is important to report when the 
communications link has failed or has become intermittent enough to cripple proper 
communication. Over time, many issues can occur to cause a bad or intermittent radio 
link. Items such as tree growth, new building construction, or another radio added at 

MIRRORED BITS 

Decoder and Integrity

Checks

ROK

RBAD 

Timer RBAD

Serial Data



Date Code 20091009 SEL-3031 Instruction Manual

Performance Monitoring, Testing, and Troubleshooting
Self-Test

5.5

the site or in the path of the current radio link. It is important to take CBAD and RBAD 
and use them in the relay to trigger an alarm condition through an output contact or 
have the SCADA system detect the alarm. Line-of-site radio paths can experience 
adverse conditions over time and it is critical to constantly monitor the radio 
performance to keep the availability numbers as high as possible.

Self-Test
All self-tests are described in Table 5.1. If all diagnostic tests are passed, the ENABLED 
LED is on, the ALARM LED is off, and the contact output is open. If the device is 
disabled, the ENABLED LED is off, the ALARM LED is illuminated, and the contact output 
is closed.

Table 5.1 Device Self-Tests

Self-Test Description
SER 
Message

Alarm 
LED

Alarm 
Contact

FPGA Version 
Mismatch

Fails if FPGA registers do not match 
expected.

Yes On Closed

Data RAM Performs read/write tests on each 
section of Data RAM.

Yes On Closed

Code RAM Performs a comparison test against 
code flash.

Yes On Closed

Code Flash Checksum is continually computed 
on code base.

No On Closed

Flash (Settings) Performs a validity test every hour 
on the settings.

Yes On Closed

Processor 
Exception

Indicates processor failure. Yes On Closed

RTC Indicates clock chip static RAM fail-
ures.

Yes On Closed
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Troubleshooting
Table 5.2 Troubleshooting Tips (Sheet 1 of 2)

Symptom Probable Cause Corrective Action

ALARM LED is ON Radio recognized a status 
failure.

Cycle power, issue STA-
TUS command. If alarm 
signal returns, return unit to 
the factory for repair.

ALARM LED flashes ON 
every half second.

Radio detected a VSWR 
error where there is an open 
or short on the antenna port.

Verify all connections from 
the antenna to the radio are 
secure. Verify the antenna, 
feedlines, or lightning arres-
tor is not damaged.

The SEC LED is flashing. The SEL-3031 properly 
detects the encryption card 
but the card is in reset and 
doesn't have the key set.

Use ACSELERATOR Quick-
Set and set the KEY setting. 
This must be set the same 
on both radios.

Cannot connect to the radio 
through the USB port.

USB driver not installed 
properly.

Check for active SEL to 
USB drivers from your PC 
in Device Manager Ports 
section. If that does not 
work, uninstall and rein-
stall the driver and restart 
your PC.

Cannot change radio set-
tings.

Invalid password. Install password disable 
jumper and change pass-
words using the PAS com-
mand. See Password 
Jumper on page 2.10 for 
information on how to dis-
able passwords.

Wall-mount radio will not 
turn on.

The polarity of the power 
supply wires is reversed.

Check the correct polarity 
and reverse if incorrect.
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The Remote radio will not 
link up to the Master.

Radio address or mode is 
not set correctly.

The Master and Remote 
radios must be set to the 
same address and have the 
same SKIP settings. Check 
that the Master radio LINK 
light is ON and that the NID 
address and SKIP setting is 
set correctly on both units.

Antennas are not pointed 
correctly, or there is a bad 
antenna cable.

Use ACSELERATOR Quick-
Set on the radio to issue the 
RAD command to check for 
signal strength. If the signal 
is low, try to re-aim both 
antennas to gain signal 
strength and check for bad 
antenna cables. See 
Section 2: Installation for 
more information on proper 
radio installation.

Table 5.2 Troubleshooting Tips (Sheet 2 of 2)

Symptom Probable Cause Corrective Action
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Firmware and Manual Versions

Firmware
Determining the Firmware Version in Your Device

To find the version number of the firmware in your SEL-3031, use the STA command 
(see STATUS Command on page 4.24 for more information). The firmware revision 
number is after the R, and the release date is after the D. For example, the following 
string shows firmware version number 100 with a release date of October 9, 2009:

FID=SEL-3031-R100-V0-Z001001-D20091009

Table A.1 lists the firmware versions, a description of any modifications, and the 
instruction manual date code that corresponds to firmware versions. The most recent 
firmware version is listed first.

Instruction Manual
The date code at the bottom of each page of this manual reflects the creation or revision 
date.

Table A.2 lists the instruction manual release dates and a description of modifications. 
The most recent instruction manual revisions are listed at the top.

Table A.1 Firmware Revision History

Firmware Identification (FID) Number Summary of Revisions
Manual 

Date Code

SEL-3031-R100-V0-Z001001-D20091009 ➤ Initial version. 20091009

Table A.2 Instruction Manual Revision History

Revision Date Summary of Revisions

20091009 ➤ Initial version.
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SEL-3044 Encryption Card

Overview
The SEL-3044 Encryption Card is a standalone card that can be added to the SEL-3031 
to encrypt the radio data being sent between SEL-3031 radio links. The SEL-3044 can 
be ordered at time of purchase or added as an upgrade. The SEL-3044 requires one 
setting to provide a very strong level of encryption over the radio link. Anytime the 
SEL-3031 is used with critical data it is strongly advised to use the SEL-3044. If you 
do not use the SEL-3044, the data between the radios can be compromised. If you want 
to encrypt the radio link an SEL-3044 is required in both radios.

NOTE: The SEL-3044 is NOT a PCMCIA card. Do not install 
in a laptop.

Figure B.1 SEL-3044 Encryption Card

NIST FIPS 140-2 Level 2 Security 
Requirements
The National Institute of Standards and Technology (NIST) developed the Federal 
Information Processing Standards (FIPS) 140-2 standard that defines the security 
requirements for a cryptographic module utilized within a security system protecting 
sensitive information in computer and telecommunications systems. 
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Protection of a cryptographic module within a security system is necessary to maintain 
the confidentiality and integrity of the information protected by the module. 
FIPS 140-2 Level 2 covers areas related to the secure design and implementation of 
a cryptographic module. 

These areas include the following:

➤ Cryptographic module specification 

➤ Cryptographic module ports and interfaces

➤ Roles, services, and authentication 

➤ Finite state model

➤ Physical security

➤ Operational environment

➤ Cryptographic key management

➤ Electromagnetic interference/electromagnetic compatibility 
(EMI/EMC)

➤ Self-tests

➤ Design assurance

➤ Mitigation of other attacks

The SEL-3044 meets FIPS 140-2 Level 2 requirements and has been submitted for 
FIPS 140-2 Level 2 security validation. The status is currently pending NIST approval. 
This level of data security provides assurance that best practices have been applied to 
the design, testing, and manufacturing of the SEL-3044.

Theory of Operation—SEL Protocol
Encryption Components

A cryptographic device consists of three components: encryption algorithm, key 
management, and device security functions.

Encryption Algorithm
The Advanced Encryption Standard (AES) algorithm with a key length of 256 bits is 
implemented in the SEL-3044. This algorithm is a secure means of encrypting data. 
The AES algorithm and key length provide proven resistance to modern cryptanalysis.
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Key Management
System key (256 bits): The system key is set by a passphrase of 8 to 80 characters. The 
passphrase is used to generate a system key. The system key is used to encrypt and 
securely transmit unique session keys (see below). It also provides a cryptographic 
authentication mechanism for rejecting session requests by unauthorized SEL-3044 
devices.

Session key (256 bits): Session keys are used to encrypt all protected user data prior to 
transmission. They are produced at system startup and periodically during sessions. 
Session keys are generated using the process outlined by FIPS 186-2. They are 
produced using an integrated physical random number generator (RNG) and a 
statistical data whitening algorithm. Session keys are purely random and are not linked 
to the system key. The use of unique session keys limits the amount of data that is 
encrypted with a single key value, thus strengthening the system against 
cryptanalytical attack. The session keys are encrypted using the system key prior to 
being exchanged between SEL-3044.

Device Security
The SEL-3044 incorporates a hardware RNG and FIPS-approved data whitener to 
guarantee that all session keys contain 256 bits of entropy (i.e., completely random). 
This guarantees that encoded messages are protected by a true cryptographic strength 
of 256 bits.

Multilevel password authentication defines user security roles.

Changing the system key can only be performed by authorized users that have Access 
Level 2 passwords.

If required, the user can reset the entire device. This allows the user to reinitialize the 
system key should the security parameters need to change due to IT security 
procedures or if the programmed system key value is lost. 

NOTE: This process requires physical access to the 
SEL-3031 and cannot be done remotely.

Security of the Transferred Data
The SEL-3044 provides data encryption with a cryptographic key strength of 256 bits. 
The SEL-3044 RNG is designed so that all possible key values are equally likely. It is 
widely accepted throughout the cryptographic community that it is not realistically 
possible to mount a successful brute force (key guessing) attack on a 256-bit key space 
with technology available today.
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Application Consideration
Two messaging structures exist to establish and maintain a secure, coherent 
communications link between two SEL-3044 devices: In-Band (IB) frames and Out-of-
Band (OOB) frames. IB frames transmit encrypted user data (i.e., data received on the 
trusted data interface) between the two protected devices (computer, IED, RTU, etc.). 
OOB frames transmit connection control data between the two SEL-3044 devices in 
the communications link. Control frames are required to implement key exchanges, 
status checks, and other functions necessary to maintain the communications link.

In-Band Message Format
IB messages consist of the encrypted data plus the frame overhead necessary to 
maintain synchronization and channel security. Figure B.2 shows the format of an IB 
frame. The shaded area is the encrypted data portion of the message.

Figure B.2 In-Band Data Packet Format

Out-of-Band Message
Out-of-Band (OOB) messages are used to exchange control information between 
SEL-3044 cards. These exchanges include loss of synchronization, request for rekey, 
and rekey information. 

IMPORTANT: During OOB message communication, data 
exchange between the devices connected to the 
SEL-3044 cannot occur. Communication will be 
temporarily halted during a rekey. 

System Settings
The system key provides encryption and secure transmission of unique session keys 
between SEL-3044 devices. It also provides a cryptographic authentication mechanism 
for rejecting session requests by unauthorized devices. Session keys provide encryption 
of all protected user data prior to transmission. An SEL-3044 produces session keys at 
system startup, and periodically during sessions, using the process outlined by FIPS 
186-2. An integrated physical RNG and statistical data-whitening algorithm generate 
purely random session keys. Through the use of these unique session keys, the 
SEL-3044 limits the amount of data encrypted by any single key value, thus 
strengthening the system against attack. 

IB Header

Maximum of 7 Bytes User-Defined Frame Length

Protected Data
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NOTE: Both SEL-3044 transceivers that communicate with 
each other must share the same system key.

AES Overview
The AES encryption function uses a 256-bit-long secret key and scrambles the contents 
of each frame prior to transmission to provide cryptographically strong data 
confidentiality.

Encryption is the process of transforming a digital message from its original form into 
a form that an unauthorized individual cannot interpret. The output of the encryption 
process is a function of the message and an encryption key (see Figure B.3).

Figure B.3 Operation of the AES Encryption Function

This encryption process must be completely reversible by an authorized individual 
with access to the secret decryption key. Authority to read a message is only granted by 
sharing knowledge of the secret decryption key. Ideally, only individuals with 
knowledge of the decryption key can reverse the encryption operation and interpret the 
protected message. There are two main classes of encryption functions. Symmetric key 
encryption relies on the same secret key value, K, to perform both the encryption and 
decryption transformations. Asymmetric key encryption, on the other hand, uses a 
different key for encryption and decryption for example, asymmetric encryption might 
use K1 for encryption and K2 for decryption. The AES encryption algorithm the 
SEL-3044 uses is a symmetric block cipher with an encryption/decryption key size of 
256 bits.

The AES is the latest encryption standard adopted by NIST. In 1997, NIST challenged 
the cryptographic community to develop the next generation encryption algorithm to 
replace the aging DES and 3DES encryption standards. In 2000, NIST chose the 
Rijndael encryption algorithm as the AES encryption standard. During the evaluation 
of candidates for the AES standard, some of the world’s best cryptanalysts analyzed 
and approved Rijndael. Since its adoption in 2001, AES has proven to be very effective 
against known attacks, very efficient, and simple to implement.

Encryption Key Decryption Key
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Frame Replay Protection
Every frame in a given session contains a sequence number field. The value in this field 
increments every time a frame is transmitted. The SEL-3044 will not accept any frame 
that contains a sequence number value that is less than, or equal to, the sequence 
number value received in the last frame. It is exceedingly difficult to maliciously alter 
the sequence number in any given frame to bypass this functionality because the 
sequence number field is protected by the strong cryptographic authentication 
mechanisms. Because of the protection these mechanisms provide, an attacker cannot 
capture a previously transmitted frame and resend the frame to the SEL-3044 to cause 
harmful actions.

Resetting the SEL-3044
At some point it may be necessary to reset the SEL-3044. You must have access to the 
front USB port on the SEL-3031. The SEL-3044 must be installed in the SEL-3031 to 
reset. Use either ACSELERATOR QuickSet® SEL-5030 Software or a terminal interface 
to access the Radio settings. In the Radio settings, set the KEY setting to None, save 
the setting, then set a new passphrase and save.

If you have lost your passwords to access the SEL-3031 then you must disable 
passwords by temporarily installing a jumper. Refer to Password Jumper on page 2.10 
and Table 2.5 for information and instructions on disabling passwords.

Installing SEL-3044 in the SEL-3031
The SEL-3044 can be ordered at time of purchase of the radio or it may be added later 
as a field upgrade. The process involves powering down the radio, removing hardware, 
installing the card, and setting the radio.

The radio contains devices sensitive to Electrostatic Discharge (ESD). When 
working on the radio with the front or top cover removed, work surfaces and 
personnel must be properly grounded or equipment damage may result.

! CAUTION

Step 1. Remove the power from the radio and remove all connections from 
the device.

Step 2. Rack-mount SEL-3031: Loosen the six front-panel screws and 
remove the front panel.

Wall-mount model: Use a Torx® T15 screwdriver and remove the 
four screws located on the sides of each corner. Slide the cover up and 
back to reveal the front of the unit.

Step 3. Between the main board and radio board there is a PCMCIA card 
slot. Gently slide the SEL-3044 straight into the card slot. Push firmly 
until it is fully seated.
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Figure B.4 Encryption Card Location

Step 4. Reassemble the unit in reverse order of Step 2.

Step 5. Apply power to the unit and verify the SEC light is flashing. The 
flashing LED shows the SEL-3044 is functioning properly and is 
currently in Reset.

If the SEC LED is not flashing, then you must turn off the unit and 
verify the card is properly seated in the pins.

If the SEC LED does not flash on power up after checking the card is 
seated properly, then you will need to send the radio and encryption 
card back for repair.

Step 6. Use ACSELERATOR QuickSet to connect to the device and set the 
KEY setting to enable the SEL-3044.

Step 7. The KEY setting must be set the same on both SEL-3031 transceivers 
for proper operation.
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